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Human Resources 4.6 (1)

Level 3Level 2

Reporting in Human
Resources

HR580 3 days 

see HR2

Human Resources
Essentials III

HR053 2 days

Configuration of Time
Recording

HR306 4 days

Time Evaluation

HR310/311 5 days 

Shift and Workforce
Planning

HR520 2 days

Human Resources
Essentials I

HR051 1 day

Organizational
Management

HR505 3 days

Employee Self-Service
HR250 2 days

Configuration of
Master Data

HR305 3 days

Personnel Development
HR510 3 days 

Training and Event
Management

HR515 3 days 

Human Resources
Essentials II

HR052 2 days

Compensation
Management

HR540 3 days 

Configuration of HR
System Controls

HR307 2 days 

Programming in HR

HR350 5 days 

Technical topics in
Human Resources

HR530 3 days 

CATS The Cross
Application Time Sheet

CA500 2 days 

Benefits Administration
HR325 3 days 
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Human Resources 4.6  (2)

Level 3Level 2

Human Resources
Essentials I

HR051 1 day

Human Resources
Essentials II

HR052 2 days

Human Resources
Essentials III

HR053 2 days

Please note our country specific curriculum and our curriculum
for release 4.6B.

 Note:

Payroll Configuration

HR400 5 days

Introduction
to Payroll

HR390 2 days 
Configuration of
Master Data

HR305 3 days 

Incentive wages

HR490 4 days 
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Course Prerequisites

z HR050 - Human Resources

z BC420 - ABAP Dictionary

z BC400 - ABAP Workbench Basics and Concepts
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Target Group

z System administrators

z Developers

 
 

Notes to the user 

� The training materials are not teach-yourself programs. They complement the course instructor's 
explanations. On the sheets, there is space for you to write down additional information. 
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Introduction

Course goal

Course content

Contents:
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Course Goal

This course provides you with information on:

Technical topics in HR
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Course Content

Unit 1 Introduction

Unit 2 Data Structures in HR

Unit 3 Customer Infotypes

Unit 4 Enhancement Options

Unit 5 ALE, Transport Link, and Data Transfer

Unit 6 Creation of Infotype Logs, Logging, and Archiving

Course Overview

Exercises

Solutions
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Course Overview Diagram

Introduction

Data Structures in HR

Customer Infotypes

ALE, Transport Link, and Data Transfer

Creation of Infotype Logs, Logging, & Archiving

Enhancement Options
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Data Structures in HR
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At the conclusion of this unit, you will be able to
define the HR data model and the database tables
and logical structures on which it is based.

Data Structures in HR: Unit Objective
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Data Model in Personnel Administration

Family Bank Details

Address/
Personal Data Org. Assignment

Employee/Applicant

Working Time

Birth
certificate

 
 

Infotypes are units of information in the Human Resources System. They are used to group data fields 
together that all relate to the same subject matter. 
Infotypes structure information, and facilitate data entry and time-dependent data storage. From the 
user's perspective, infotypes are data entry screens. From the database perspective, infotypes are a data 
structure and a set of data records that belong together.  
The ability to create histories for infotypes is ensured by time-dependent infotype storage. The system 
records a validity period for each infotype record. Each infotype entered for an employee usually has 
several data records that are distinguished one from the other by their validity periods. 

Time constraints enable you to determine how the validity periods of infotype data records interact: 

Time constraint 1: Exactly one valid data record of the infotype in question must exist for the entire 
time that the employee belongs to the enterprise. 
Time constraint 2: No more than one valid data record of the infotype in question can exist at any one 
time. 
Time constraint 3: Any number of valid data records of the infotype in question can exist at any one 
time. 
The prerequisites for the existence of a personnel or applicant number are infotypes 0000 Actions, 0001 
Organizational Assignment, 0002 Personal Data, and 0003 Payroll Status. 
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Data Model in Personnel Planning I

holder

describes incorporates

holder

is assigned

z Object-oriented design - object types

belongs to

describes

Work center

External OT

Cost center

Person

Position

Object type

Organizational
unit

Job

Task

 
 

� The data model in Personnel Planning is based on an object-oriented design. 

� The following terms constitute the basis of this object-oriented design: 

y Object Types 

y Relationships 

y Infotypes 

� Object types are used to classify objects in Personnel Planning (organizational units, positions, jobs, 
etc.), which means that each object in Personnel Planning is assigned to just one object type. 

� Object types are defined in table T778O by a 2-character CHAR string.  
The namespace A* - Z* is reserved for SAP, the namespace 0* - 9* for customers. 

� With regard to the origin of a master record, a technical distinction is made between 

y Internal object types, whose master record is stored in Personnel Planning database tables (such 
as organizational units, positions, jobs, etc.) 

y External object types, whose master record is stored in the database tables of other SAP 
applications (such as persons, cost centers, and so on). Within Personnel Planning, relationships 
are used to reference these external object types. To define an external object type, an interface 
program (example/template: RHPREL00) and an entry in table T77EO must be created. 
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Data Model in Personnel Planning II

holder

describes incorporates

holder

is
assigned

z Object-oriented design - relationships
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described
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� Relationships enable you to define links between individual object types in the system. 

� Relationships are defined in table T778V by a 3-character CHAR string.  
The namespace is delimited in table TRESC as follows:  

y SAP: ‘000’ - ‘999’ 

y Customer: ‘AAA’ - ‘ZZZ’ 

� Relationships are generally defined in two directions: A = bottom up and B = top down.  

� Example: relationship 003 ("incorporates/belongs to") is defined in the following two directions: 

y A003 'belongs to'  and B003 'incorporates'    

� This "convention" is no more than a default when the relationship is set up for the first time. It is not 
binding. However, it is important not to change or invert an assignment to directions A and B once 
it has been decided. 

� Each relationship for internal object types is also stored physically in both directions on the 
database. Under certain circumstances, just one direction is stored on the database for external 
object types, depending on the key structure of the external object type. The relationship to the 
external object is stored (external object types without an inverse relationship). 
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Data Model in Personnel Planning III

z Object-oriented design - infotypes
Infotypes

Cost center

Work center

Organizational
unit

PositionJob

PersonTask

 
 

� Personnel Planning infotypes enable you to describe and define the various characteristics and 
attributes of an object. After you have created an object (such as an organizational unit, 
qualification, or business event), you determine its characteristics by appending various infotypes.  

� All of the information on objects is stored in the system as infotypes, particularly the object itself 
(that is, its master record) and the object's relationships.  For this reason, infotypes 1000 Object and 
1001 Relationships constitute the core Personnel Planning infotypes.  

� Usually, you use infotype 1000 Object to create new objects, and infotype 1001 Relationships to 
determine the links between the objects. You must process infotype 1000 Object before processing 
other Personnel Planning infotypes.  

� The infotype concept in Personnel Planning corresponds to the infotype concept in Personnel 
Administration. However, you must not confuse Personnel Planning infotypes with Personnel 
Administration infotypes because they are stored in different database tables.  
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z T7780/T7770
z T77EO
z T778V/T777V
z T777E
z T77AR
z T777Z
z T778T/T777T
z T777I
z T778U/T777U

 Object Types
 External Object Types
 Relationships
 Allowed Relationships
 Additional Data on Relationships
 Infotype Time Constraint
 Infotypes
 Infotypes per Object Type
 Subtypes

Important Customizing Tables for Data Model in
Personnel Planning

 
 

� You can access the individual tables by choosing the following path in the Implementation Guide: 

y Personnel Management Æ Organizational Management Æ Basic Settings Æ Data Model 
Enhancement 
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Consistency Check for Data ModeI

z Consistency checks for customizing data model

z Infotypes/additional data
- Object type assignment
- Time constraint
- Structures
- Database tables

ÎReport RHCHECK0
checks that Customizing of the data model in Personnel Planning is
consistent

z Integration
- Active or inactive
- Active plan version

z Relationships
- Allowed relationships (object type assignment)
- Time constraint

 
 

 

 
                                         

 



© SAP AG HR530 2-10 

  SAP AG 1999

Transparent Tables for Infotypes

z Technical implementation - transparent tables

Each infotype has a transparent table.

Each logical field for an infotype has a corresponding
physical field on the database.

Infotype tables = transparent tables.

Field 2...KEY Field 1

infotype-specific length

Structure of infotype table

...

... ...

PA0000 PAnnnn HRP1000 HRPnnnn

 
 

� One physical table is stored on the database for each transparent table. The names of the physical 
table and logical table definition in the Dictionary are compatible.  

� The following naming convention applies to infotype tables; from now on, nnnn stands for the 
infotype number: 

y PAnnnn for transparent tables in Personnel Administration 

y PBnnnn for transparent tables in Recruitment 

y HRPnnnn for transparent tables in Personnel Planning 
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Check and Control Tables for HR Infotypes

Check table for all
HR infotypes

Additions to table
T777D

T777D

T77ID

T582A
(Personnel Administration)

T77CD
(Personnel Planning)

 
 

� Table T777D Infotypes - Dialog/Database Assignment is the central check table (domain 
INFOTYP) for all HR infotypes (Administration and Planning infotypes). It is used to store the 
names of all infotype-dependent repository objects (tables, structures, programs, and so on).  

� Table T77ID Infotypes: Enhancements to T777D is simply an enhancement of table T777D that 
exists for reasons of memory space.  

� Table T582A Infotypes - Customer-Specific Settings is used for customer settings in Administration 
infotypes.  

� Table T77CD Infotypes - Customer-Specific Settings is used for customer settings in Planning 
infotypes.  

� Report RHT777DCHECK enables you to check the consistency of entries in these tables. 
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Check Table for HR Infotypes

z Infotype control

Table T777D

IT

0000
0001
...
1000
1001
1002
...
9998
9999

Structure

P0000
P0001

P1000
P1001
P1002

P9998
P9999

DB table

PA0000
PA0001

HRP1000
HRP1001
HRP1002

PA9998
HRP9999

DB table
Table IT

HRT1002

 
 

� Table T777D Infotypes - Dialog/Database Assignment is maintained automatically by the tool used 
to create new infotypes (see unit 3). Do not process this table manually. 

� Each infotype in the Human Resources System has a transparent table PAnnnn or HRPnnnn and a 
Pnnnn logical structure (stored in T777D-PPNNN).  

� Logical structures are used to define interfaces between programs or between screens and programs. 
A logical structure does not have any data records on the database.  

� To avoid direct database access, these Pnnnn logical structures are normally used in Human 
Resources System programs. 
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Infotypes - Additions to Table T777D

Infotype

0000
0001
...
1000
1003
...
1611
1612
...
9998
9999

Structure of IT-specific fields

PS0000
PS0001

HRI1000
HRI1003

HRI1611
HRI1612

PS9998
HRI9999

Primary table for ext. IT

V_T5U27
V_T5U26

Table T77ID

 
 

� Table T77ID Infotypes: Enhancements to T777D is simply an enhancement of table T777D 
Infotypes - Dialog/Database Assignment that exists for reasons of memory space. 

� This table is used to store structure PSnnnn or HRInnnn for the infotype-specific fields of each 
infotype.  
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Structure of Transparent Tables

The structure of transparent tables:

. . .

Key for infotype PA0001 BUKRS ABKRS   ...

Key for infotype PA0002 NACHN VORNA  ...

. . .

Key for infotype HRP1001 SCLAS SOBID   ...

. . .

Key for infotype HRP1003 STABS ABTEL  ...

 
 

� A minimum set of table fields - whose values give a unique identity to each data record in the table - 
is known as the table's primary key. In this context, "minimum" means that removing any one of 
the fields from the key would mean that the remaining fields no longer give the data records a 
unique identity. 

� The fields included in a primary key are known as the table's key fields. A combination of key field 
values can only occur once in a table. 

� A transparent table consists of the primary key and other non-key fields. In particular, the non-
key fields for infotype tables include the infotype-specific fields that contain the actual infotype data 
or information.  

 

 
                                         

 



© SAP AG HR530 2-15 

  SAP AG 1999

Transparent Tables in Personnel Administration

z Transparent tables: dictionary field definition 

Example: PA0002

.INCLUDE PAKEY

.INCLUDE PS0002

.INCLUDE PSHD1

MANDT PERNR
SUBTY
...
SEQNR

AEDTM
...
PREAS

INITS
NACHN
...
INCLUDE CI_P0002

 
 

� In the Dictionary, each PAnnnn infotype table is defined with the client (field MANDT) using the 
following three include structures: 

y PAKEY: 
contains the key fields of the infotype table 

y PSHD1: 
contains administrative information on the infotype record (including the date on which it was last 
changed, and the user name of the person who made this last change) 

y PSnnnn: 
contains the infotype-specific fields with the actual infotype data or information 

� To ensure that transparent table PAnnnn and logical structure Pnnnn always remain mutually 
consistent, structure PSnnnn is also included by structure Pnnnn.  
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Key Fields for Infotypes in Personnel
Administration

.INCLUDE PAKEY
PERNR

SUBTY

OBJPS

SPRPS

ENDDA

BEGDA

SEQNR

 
 

� The primary key of transparent table PAnnnn consists of the following key fields: 

 PERNR: the personnel number is the only unique key within a client for identifying an employee. It 
is used to access the display and maintenance screens for an employee's master data and working 
time data (infotypes). 
SUBTY: subtypes are subdivisions of infotypes. An infotype's subtypes can have different time 
constraints and form their own histories. 
OBJPS: the object identification is used to make a distinction between records with the same 
infotype, subtype, lock indicator, start date, and end date. Example: the child number in infotype 
0021 Family/Related Person. 
SPRPS: the lock indicator for HR master data enables you to lock and unlock data records. This 
facilitates the double verification principle. In accordance with this principle, at least two users are 
involved in the process of writing an active data record to the database. One of the users creates a 
locked infotype record. A different user unlocks - that is, activates - this data record.  
ENDDA: end date. 
BEGDA: start date. 
SEQNR: the sequential number is used to make a distinction between infotype records that have the 
same key and time constraint 3 (any number of valid infotype data records at any one time). Unlike 
the object identification, it is assigned by the system automatically. 
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Transparent Tables in Personnel Planning

.INCLUDE HRIKEY

INFTY
OTJID
.INCLUDE HRIADMIN

.INCLUDE HRI1003

MANDT
PLVAR
...
SEQNR

AEDTM
...
ITXNR

STABS
ABTEL
.INCLUDE CI_P1003

z Transparent tables: dictionary field definition 

Example: HRP1003

 
 

� In the Dictionary, each HRPnnnn infotype table is defined using the following three include 
structures: 

y HRIKEY: 
contains the key fields of the infotype table 

y HRIADMIN: 
contains administrative information on the infotype record (including the date on which it was last 
changed, and the user name of the person who made this last change) 

y HRInnnn: 
contains the infotype-specific fields with the actual infotype data or information 

� To ensure that transparent table HRPnnnn and logical structure Pnnnn always remain mutually 
consistent, structure HRInnnn is also included by structure Pnnnn.  
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Key Fields for Infotypes in Personnel Planning

MANDT

PLVAR

OTYPE

OBJID

SUBTY

ISTAT

BEGDA

ENDDA

VARYF

SEQNR

.INCLUDE HRIKEY

 
 

� The primary key of transparent table HRPnnnn consists of the following key fields: 

 MANDT: legally and organizationally independent participant in the system. 
PLVAR: a one or two-character alphanumeric plan version key that is used to make a distinction 
between different organizational plans. 
OTYPE: a one or two-character alphanumeric object key (such as ‘S’ for position, ‘Q’ for 
qualification, and ‘E’ for business event). 
OBJID: an eight-digit, non-mnemonic key that represents a single object (such as an organizational 
unit, qualification, or business event). 
SUBTY: subtypes are subdivisions of infotypes. An infotype's subtypes can have different time 
constraints and form their own histories. 
ISTAT: a one-digit key that stands for a planning status. All objects and their defining infotypes 
have a status. This enables you to put objects and infotypes through a planning cycle. 
BEGDA: end date. 
ENDDA: start date. 
VARYF: variation field of the PLOG file (that contains the target object for relationships). 
SEQNR: the sequential number is used to make a distinction between infotype records that have 
the same key and time constraint 3 (any number of valid infotype data records at any one time). It is 
assigned by the system automatically. 
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Language-Dependent Infotypes in Personnel
Planning

.INCLUDE HRIKEYL

MANDT

PLVAR

OTYPE

OBJID

SUBTY

ISTAT

BEGDA

ENDDA

LANGU

DUMMY

SEQNR

 
 

� Language-dependent infotypes contain one or more text fields (type: TEXT) that can be 
translated.  

� The flag which indicates that an infotype is language-dependent is set in table T777D in the LANGU 
("language-dependency") field.  

� Examples of language-dependent infotypes in the standard system:  

y Infotype 1000 (Object): the object's short and long text can be translated. 

y Infotype 1002 (Description): a text of any length can be translated. 

� To enable the language of an infotype record to be stored in language-dependent infotype records, a 
slightly modified primary key structure (HRIKEYL) is used for language-dependent infotypes 
instead of HRIKEY for language-independent infotypes. The language of the infotype record is 
stored as the first character of the VARYF field. In other words, instead of the ten-character 
VARYF field, the HRIKEYL primary key structure contains the following fields: 

y LANGU (language indicator) - length of 1 

y FILLER (filler field) - length of 9 

- The only difference between the key of a language-dependent infotype record and the key of 
its translated infotype records is the LANGU field. All other key fields are identical.  
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Database Tables for Applicant Infotypes

z Applicant infotype control

IT

0000
0001
0002
…
0006
0007
…
4000
4001
4002

DB table

PA0000
PA0001
PA0002

PA0006
PA0007 

DB table for applicant
infotype

PB0001
PB0002

PB0006
PB0007

PB4000
PB4001
PB4002

Table T777D

 
 

� Infotype records for applicant infotypes are stored in PBnnnn transparent tables, the structure of 
which is the same as in PAnnnn tables. 

� A distinction is made between  

y Infotypes that can be maintained for employees and applicants (such as 0001, 0002, 0006, and 
0007). In this case, a Pannnn database table exists for employee data, and a PBnnnn database 
table exists for applicant data. 

y Infotypes that can only be maintained for applicants (“pure applicant infotypes” with infotype 
numbers from 4000 through 4999). In this case, just one database table exists for applicant data 
(PB4nnn).  
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z Subtype control

Subtypes for Infotypes in Personnel Administration

IT

0006
...

0008
0009
0010
0011

...
0019

...
0022

Subty. field

ANSSA

SUBTY
BNKSA
LFDNR
LGART

TMART

SLART

Subty. table

T591A

T591A
T591A
T591A
T512Z

T531

T517T

Subty. text tab.

T591S

T591S
T591S
T591S
T512T

T531S

T517T

TC table

T591A

T591A
T591A
T591A
T591B

Table T777D

 
 

� Subtypes are used to subdivide infotypes. For example, infotype 0006 (Address) can be divided into 
main addresses, temporary addresses, and business addresses, etc.   

� The following fields in table T777D are used to define subtypes.  

Subtype field: This contains the field in the infotype structure that contains the subtype. This is 
generally the SUBTY field. However, it can also contain a field other than the SUBTY field and, in 
addition, the value of the subtype (for example,  ANSSA = address type in infotype 0006). 

Subtype table: This contains the check table that contains all of the subtype values allowed for each 
infotype. This is generally table T591A. Depending on the subtype field, the subtype values can be 
stored in a different table. For example, table T512Z (Permissibility of Wage Types per Infotype) 
can be used for infotype 0011 (External Bank Transfers) because the wage type (the LGART field) is 
used as the subtype. 

Subtype text table: This contains the text table for the subtype table, that is, the table with the 
names of individual subtype values. This is generally table T591S provided that table T591A is used 
as a subtype table. If a different subtype table is used (such as T512Z), its text table (such as T512T) 
is stored here. 

Time constraint table: If the time constraint is dependent on the subtype, this contains the time 
constraint table (for example, T591A/T591B). 

Country-specific subtypes: This field is discussed in HR307 ("Configuration of HR System 
Controls"). 
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Infotype Views/Additional Infotypes I

Tables T582V/T582W: View definition - assignment of additional IT to primary IT 

Primary infotype PA0021

Secondary (additional) infotype PA0335

z Infotype view that consists of primary and secondary (additional) infotype

Key PA0021 FAMSA FGBDT EMRGN...

Key PA0335 FULNA FINUM DADEA...

 
 

� Many country versions require country-specific fields that are appended to international infotypes, 
such as Organizational Assignment, Family/Related Person, etc. 

� To ensure that the structures of international infotypes do not contain an excessive number of 
country-specific fields, such country-specific fields are stored in additional infotypes. 

� In table T777D, additional infotypes are assigned the value "Z" in the "Infotype/view" field. 
International infotypes ("primary infotypes") are assigned the value "I".  

� The primary infotype and additional infotype are maintained together on one screen in an infotype 
view. When the data you have maintained is saved, it is divided into two infotype records (a primary 
infotype record and an additional infotype record) with an identical infotype key.   

� The infotype menu only contains the international primary infotype. The additional infotype can 
only be maintained together with the primary infotype. It cannot be maintained on its own. All 
infotype attributes, such as the time constraint, are defined in the primary infotype only. 

� Infotype views are defined using tables T582V and T582W. 

� When the personnel number is created, a view indicator is assigned in infotype 0003 using feature 
IVWID. This view indicator is used to select secondary infotypes. For obvious reasons, this view 
indicator must NOT EVER be changed.  
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Additional Relationship Data I

z Definition - additional relationship data 

Î Example: "requires" relationship between a position and qualification

Î Table T77AR: name of additional data structure (PADnn) for relationship type

Î "Infotype" at the relationship, i.e. attributes that cannot be stored in isolation as
    infotypes for the objects in question because they only refer to the specific
    relationship between two objects

Qualification

is required by

requires

Position

Add. data:
proficiency
experience

 
 

� In table T77AR, a specific additional data structure can be assigned to more than one relationship 
type.  

� At this time, the additional data concept has not been applied to customer enhancements. Customer-
specific additional data cannot be created without modifying core infotype 1001. Do not do this 
without consulting SAP first. 
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Additional Relationship Data II

Table T77AD: Name of database table for an additional data structure

Infotype HRP1001

HRPADnn

z Technical implementation - additional data

Key HRP1001 SCLAS SOBID ADATANR...

Key: ADATANR Add. data field 1 Add. data field 2 ...

PADnn

 
 

� The structure of additional data depends on the type of relationship. For this reason, the additional 
data of structure PADnn must be stored in separate table HRPADnn (assignment in table T77AD).  

� The link between a relationship record (table HRP1001) and an additional data record (table 
HRPADnn) is established by an additional data pointer (field ADATANR). The additional data 
pointer is determined internally by SAP using internal number assignment. It must not be externally 
manipulated.  

� To avoid direct database access to table HRPADnn, logical structure PADnn should always be used 
when you work with additional data - just like when you work with infotype records.   

� Logical structure P1001 of a relationship record (infotype 1001) is used to store additional data in 
the ADATA field. Depending on the type of relationship, the content of the P1001-ADATA field 
must be transferred to the appropriate PADnn additional data structure (in accordance with table 
T77AR). 
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Table Infotypes in Personnel Planning

Table infotype HRPnnnn

HRTnnnn

z Technical implementation - table infotypes

Key: TABNR, TABSEQNR Table field 1 ...

PTnnnn

Table field 2

Key: TABNR, TABSEQNR Table field 1 ...Table field 2

Key: TABNR, TABSEQNR Table field 1 ...Table field 2

Key HRPnnnn Field 1 TABNR...

 
 

� Table infotypes are infotypes whose data part includes a repetition structure of any length (such as 
texts consisting of any number of lines, or courses consisting of any number of days). To enable 
repetitions of any length to be stored, the data part must be stored with the repetition structure 
("table part", defined by logical structure PTnnnn) in separate table HRTnnnn. The name of this 
transparent table is stored in table T777D in the TBTAB field ("database table for table infotype"). 
In this way, the T777D-TBTAB field is used to flag a table infotype. 

� The link between a primary record (table HRPnnnn) and a table part (table HRTnnnn) is established 
by a table pointer (field TABNR). Just like the additional data pointer, the table pointer is 
determined internally by SAP using internal number assignment. It must not be externally 
manipulated.  

� To avoid direct database access to table HRTnnnn, logical structure PTnnnn should always be used 
for the table part when you work with table infotypes - just like when you work with infotype 
records.   
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External Object Types and Relationships

z Definition: external object types and relationships

Î Table T77EO (IMG path: "Maintain Object Types" - "External Object Types")

Î External relationships = simulation of complete relationships, that is, no 
relationship direction is stored physically in HRP1001 (table T77EV; IMG path:
"Maintain Relationships" - "Allowed Relationships" - "External Relationships").

Î External object types = object types that are not stored in PD structures (that 
is, no record in HRP1000); instead, they are simply referred to in the context 
of relationship records (records in HRP1001 only)

Object type
P
K
...

Key structure
PKEYS
PKEYK

Inverse rel.
X

Interface
RHPREL00
RHKOST00

Depending on the key structure, a distinction is made between external object 
types with a physical inverse relationship in HRP1001 (for example, persons 
from PA), or without (for example, cost centers from CO).

 
 

� To ensure that an inverse relationship can be created in table HRP1001 for an external object type, 
the key structure of the external object type must be of type NUMC and have a length of 8 (8-digit 
character key). In other words, it must be of the same type as the object ID field (HRPnnnn-OBJID) 
in the infotype tables. When an external object type is set up for the first time, the "inverse 
relationship" field (T77EO-INREL) must be set in table T77EO. It is not possible to change this 
setting at a later date in a live system. If you were to do so, inconsistencies could result.  

� Even if no physical inverse relationships (for example, a cost center) exist in table HRP1001 for an 
external object type (in other words, relationships only exist to objects of this object type, such as 
relationships to the cost center), evaluations or requests are often required starting from objects of 
this object type. This means that a relationship is evaluated that does not physically exist in this 
direction in table HRP1001 (for example, which positions are assigned to cost center xyz?) The 
system then returns these "simulated inverse relationships" in the HRI1001 structure to report and 
function modules. (Note: you must not confuse structure HRI1001 with structure HRInnnn for the 
infotype-specific fields of an infotype.) The only difference between structure HRI1001 and logical 
structure P1001 of the relationship record is the type of field OBJID. Instead of type NUMC with a 
length of 8, HRI1001-OBJID is of type CHAR with a length of 45, which means that the "enhanced 
object ID" can include any external key with a maximum length of 45. This corresponds to the type 
of field P1001-SOBID, that is, the target object ID of a relationship record. 
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z Definition: external infotypes
Î External infotypes = simulation of information on Personnel Planning objects, 

which are only stored in Customizing tables for Administration and not in 
transparent infotype tables HRPnnnn, as a Personnel Planning infotype

Î For example: additional job data for the USA, infotype 1610 and T5U13

EEOCT   EXMPT AAPCT

HRP1610

T5U13
Key P1610 EEOCT EXMPT AAPCT

Structure P1610

External Infotypes in Personnel Planning

 
 

� For a variety of reasons, some information on Personnel Planning objects is not stored physically in 
Personnel Planning infotype tables. Instead, it is stored physically in Personnel Administration 
customizing tables, for example.  

� This information needs to be simulated as external infotypes in logical structure Pnnnn so that it 
can be displayed as an infotype in basic Personnel Planning transactions (for example, detail 
maintenance) and evaluated in reports of logical database PCH using the INFOTYPES statement. 
However, these external infotypes can only be maintained using the appropriate maintenance view 
of the pertinent customizing table (primary table). Therefore, an external infotype has a logical 
structure Pnnnn but no transparent table HRPnnnn. 

� An external infotype is flagged in table T777D in the EXT_INFTY field ("external infotype").  

� Control is determined in table T77ID using the following fields: 

� EXT_TABNAM ("primary table for external infotype"): view of pertinent customizing table 
EXT_W_FUNC ("function module for table name"): function module if view is determined 
dynamically during runtime 
EXT_R_FUNC ("function module for read access"): function module for read access to primary 
table, which means that this module returns infotype data of an object to structure Pnnnn. 

� Customer-specific external infotypes should only be created after consultation with SAP. 
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z Definition: country-specific infotypes

Î Table T77NI (IMG path: "Infotype Maintenance" - "Maintain Country-Specific Infotypes")

Î Country-specific infotypes = infotypes only relevant to a specific country 
that are only displayed in general infotype overviews if the appropriate country 
indicator is entered

IT
1600
1601
1610
1611
...

Country indicator
FR
FR
US
US

Country-Specific Infotypes in Personnel Planning

 
 

� Country-specific infotypes are flagged in table T777D in the NAT_INFTY ("country-specific 
infotype") field. 

� Table T77NI is used to assign a country-specific infotype to one or more country indicators (from 
table T005). 

� If you enter the country indicator in detail maintenance (by POPUP) and in report RHDESC00 (by 
parameter), the appropriate country-specific infotypes are also shown in infotype overviews.  

� User-specific country indicator defaults can be defined using the PNI SPA/GPA parameter. A 
maximum of six country indicators can be stored here.  The PNALL SPA/GPA parameter can be 
used to activate general display of all country-specific infotypes. 
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Logical Structures and Database Tables in HR

DB tables

Logical
Structures

Personnel Administration
and Planning

Personnel
Planning

PLOGI

HRPADnnHRTnnnnHRPnnnnPAnnnn

Pnnnn PTnnnn PADnn

 
 

� Each infotype nnnn has: 
- a logical structure Pnnnn 
- a transparent table PAnnnn (Administration infotype) or HRPnnnn (Planning infotype) 

� In addition, each table infotype nnnn has the following in Personnel Planning: 
- a logical structure PTnnnn for the table part 
- a transparent table HRTnnnn for the table part 

� Each relationship type also exists with additional data: 
- a maximum of one logical structure PADnn for the additional data of this relationship type 
- a maximum of one transparent table HRPADnn for the additional data of this relationship type 

� The logical structures are directly relevant to programming in HR. Direct access to transparent 
tables is not required and should, therefore, be avoided.  

� For infotype 1000, transparent table PLOGI is a redundant directory of all Personnel Planning 
objects. It is used for reports.  

� For each Personnel Planning object, the table contains just one entry with the object identification:  

� MANDT (client)/PLVAR (plan version)/OTYPE (object type)/OBJID (object ID)  

� The table can be displayed and built up using report RHPLOGI0. 
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z You now have an overview of the data models in
Personnel Administration and Personnel Planning.

z You have learned about transparent tables PAnnnn
and HRPnnnn and the Pnnnn logical structures,
which exist for each infotype in the Human Resources
System.

Data Structures in HR: Summary

 
 

 

 
                                         

 



© SAP AG HR530 2-31 

Exercises 

 
 

 

Unit: Data Structures in HR 
Topic: Object Types and Relationships 

 
 

At the conclusion of these exercises, you will be able to: 

• Create new object types and relationships in Customizing. 

 

 
 

You want to enhance the object-oriented Personnel Planning model with 
new object types and relationships. 

1 You want to manage office reservations in Organizational Management. Offices can be 
reserved by organizational units. 

1-1 Create a new object type with the object type abbreviation "##" and the name 
"Office ##". ## is your two-digit group number.  

1-2 Make sure that relationships and descriptions can be maintained for objects of 
this type. 

1-3 Create a new relationship to indicate which organizational units reserve which 
offices. Several organizational units can share one office. However, you must 
prevent offices from being reserved by too many organizational units. Create a 
relationship with the abbreviation "Y##" and the names "reserves (##)" and "is 
reserved by (##)".  

1-4 Create an evaluation path to illustrate the assignment of offices in the 
organizational structure. To do so, use customizing transaction OOAW. 

1-5 Access General Structure Maintenance in the Organizational Management 
menu. Create objects for your new object type, and link them to organizational 
units using your new relationship. You can choose any organizational units, for 
example from the IDES model company (object ID 00000001). 
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Exercises 

 
 

 

Unit: Data Structures in HR 
Topic: Selection Using Table T777D 

 
 

At the conclusion of these exercises, you will be able to: 

• Outline important fields/indicators in table T777D. 

 

2 Use transaction SE16 Data Browser to create an overview of all 

• Table infotypes 

• Language-dependent infotypes 

• Country-specific infotypes 

• Infotypes that can be maintained for applicants 

• Infotypes that can only ever be maintained for applicants 

• Additional infotypes 
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Solutions 

 
 

 

Unit: Data Structures in HR 
Topic: Object Types and Relationships 

1 You want to manage office reservations in Organizational Management. Offices can be 
reserved by organizational units. 

1-1 Access the SAP Implementation Guide by choosing Tools → AcceleratedSAP 
→ Customizing → Project Management → SAP Reference IMG. In the IMG, 
choose Personnel Management → Organizational Management → Basic 
Settings → Data Model Enhancement → Maintain Object Types. To create a 
new object type with the object type abbreviation "##" and the name "Office 
##", use the New entries function. ## is your two-digit group number.  

1-2 Choose the following IMG activity: Infotype Maintenance →  Maintain 
Infotypes. Include your new object type in infotypes 1000, 1001, and 1002. 

1-3 Choose the following IMG activity: Relationship Maintenance →  Maintain 
Relationships. Create a new entry with the abbreviation "Y##" and the names 
"reserves (##)" and "is reserved by (##)".  

1-3-1 When you perform the Relationship Characteristics step, enter the B 
direction for your relationship ("is reserved by (##)") with a warning if 
100% is exceeded. 

1-3-2 When you perform the Additional Data on Relationships step, enter 
your relationship and select the Relationship percentage indicator. 

1-3-3 When you perform the Allowed Relationships step, enter both of your 
new relationship's directions from and to the organizational unit object 
type. 

1-3-4 Choose the following IMG activity: Infotype Maintenance →  
Maintain Subtypes. Enter the new subtypes, AY## and BY##, with 
appropriate texts for infotype 1001. Maintain the time constraint for 
your new object type ##, infotype 1001, and subtype BY##, and for 
object type O (organizational unit), infotype 1001, and subtype AY##. 
In both cases, the value of the time constraint is "3".  
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1-4 To maintain evaluation paths, access customizing transaction OOAW. In the 
first step, create the abbreviation and name of your new evaluation path. The 
abbreviation must start with Y##. In the second step, enter a name for the 
individual steps of the evaluation path. Define an evaluation path: 

10 O A Y## reserves * ## 
20 O B 002 is line supervisor of * O 

1-5 Access General Structure Maintenance for your newly defined evaluation path 
by choosing Human Resources → Organizational Management →  
Organizational Plan → General Structures → Change. Under Object type, 
enter Organizational unit and under Object ID, 1. Create offices, and 
relationships to organizational units.  
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Customer Infotypes
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Customer Infotypes: Unit Objectives

At the conclusion of this unit, you will be able to:

z Create or enhance infotypes if the infotypes
included in the standard system do not meet
your requirements.
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Introduction

Data Structures in HR

Customer Infotypes

ALE, Transport Link, and Data Transfer

Creation of Infotype Logs, Logging, and Archiving

Enhancement Options

Course Overview Diagram
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Elements of an Infotype

z "What is an infotype?"

Standard infotypes:

...

0000

Actions

(action type)

Î Structure definition in Repository
Î Database table
Î Processing program (module pool)
Î Screens 1000, 2000, 3000
Î Table entries for control

Key fields, general fields, PSnnnn
PAnnnn or HRPnnnn
MPnnnn00
MPnnnn00 / 1000, 2000, 3000
e.g. T582A, T582S, T777I, T777Z, …

0001

Org.
Assignment

(org. unit)

1000

Object

(abbreviation)

1001

Relationships

(relationship
type,
target object)

1002

Verbal
Description

(text)

 
 

� An infotype has an entry in check table T777D, and several infotype-dependent elements in the 
Repository.  

� In addition to the structures and database tables discussed in unit 2 (Data Structures in HR), each 
infotype has a module pool containing the infotype-specific entry and list screens with their 
validations, and a dialog module. 

� When you create individual elements, take careful note of the following:  

y Some infotype-dependent infotype objects must be processed using the Data Dictionary. 

y Some infotype elements must be processed using the infotype copy programs in Personnel 
Planning and Personnel Administration. They have been created for this specific purpose. 

y Some infotype-dependent settings must be entered using customizing for infotypes. 

 If you observe these notes, you can avoid inconsistencies in infotype-dependent objects and table 
entries. More detailed information on how to create and enhance infotypes is included in later 
sections of this unit. 
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Namespace Definitions for Infotypes

Infotype structures
Standard: P0000 - P1999
Customer: P9000 - P9999

Infotype-specific fields
Standard: PS0000 - PS0999 or

HRI1000 - HRI1999
Customer: PS9000 - PS9999 or

HRI9000 - HRI9999

Database tables
Standard: PA0000 - PA0999 or

HRP1000 - HRP1999
Customer: PA9000 - PA9999 or

HRP9000 - HRP9999

z Namespaces for infotypes

 
 

� When working with infotypes, it is important to comply with the above namespace conventions.  

� Other namespace conventions for standard infotypes:  

y Time Management infotypes are assigned to namespace 2000-2999 

y Recruitment infotypes are assigned to namespace 4000-4999 

� Namespace enhancement 

y In Release 4.0A, infotypes are not included in the namespace enhancement. 

y In Release 4.5A, the Repository objects of infotypes can be created with a namespace prefix. The 
infotypes themselves, however, cannot be created with a prefix. 

 If you require detailed information on the general namespace enhancement, see CSS note 16466: 
Customer namespace for SAP objects. 
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In standard fields
of
standard infotypes

??
In customer include
of standard infotypes

In customer infotypes
(created for
this purpose)

 Standard
field

Infotype
nnnn

z Where can enterprise-specific information be stored?

Infotype
nnnn

Customer
include

Infotype
9nnn

Specific
fields

Standard Infotypes vs. Customer Infotypes

 
 

� There are three different ways of storing customer-specific information in infotypes: 

y You can use the fields that already exist in standard infotypes. For example, you can store the 
required information in a specific field of a standard infotype that you have not used before. 

y You can enhance a standard infotype, which means creating the fields that you require in a 
customer include. 

y You can create a new infotype with the fields that you require.  

� Before you enhance standard infotypes or create new infotypes, you should always determine 
whether the infotypes included in the standard system meet your requirements. 
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Using Standard Infotypes

? ?
? !

z When a suitable field exists in the standard infotypes.

 Company car

Infotype
1010:

Infotype
0000

Infotype
1001

Infotype
1000

z When can you work with standard infotypes?

 
 

� Problem:  You want to store specific information in the system. 

� Procedure:  Check all of the standard infotypes to determine whether one of the fields 
 in a standard infotype can be used to store this information.  

� Situation: You find an infotype that contains a suitable field. 

� Procedure: Use this infotype to store your specific information. 

� Example:  You want to store the following information: "position entitled to company car". 

 Use standard infotype 1010 (Authorities/Resources). 

� Note: You can obtain information on specific fields from infotype-specific structure Pnnnn  
  (or from the PSnnnn or HRInnnn structure). 
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Enhancing Standard Infotypes

? ?

z When a standard infotype meets most of your requirements.

? !
Infotype
1003

Infotype
1000 Infotype

0000

Infotype
1001

Department ! 
Staff ! 
?

z When can you work with an enhancement to standard infotypes?

 
 

� Problem:  You want to store specific information in the system. 

� Procedure:  Check all of the standard infotypes to determine whether one of the fields 
 in a standard infotype can be used to store this information.  

� Situation: You find an infotype that is suitable for most of your data. However, 
 additional fields are required. 

� Procedure: Use this infotype's customer include structure (CI_Pnnnn) to store your specific 
 information by including the fields you require in this structure. 

� Example:  You want to store information on an organizational unit to determine that it 
 manages a project.  

 You can use the customer include for standard infotype 1003 (Department/Staff) 
 by enhancing it with the "project management" field.  

� Advantage: The enhanced infotype does not change the infotype defined in the standard system.  
 In particular, you are not required to convert the database for a release upgrade 
 if SAP simultaneously enhances this infotype in the standard system (the 
 sequence of fields in the Dictionary and database could differ).  
 The changes required for evaluations are also minimized. 
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Customer Infotypes

? ?
?

?

?
Infotype
1001

Infotype
0000

Infotype
nnnn

Infotype
1000

z When can you work with customer infotypes?

z When you cannot store the required information in any
of the standard infotypes.

 
 

� Problem:  You want to store specific information in the system. 

� Procedure:  Check all of the standard infotypes to determine whether the fields 
 in a standard infotype can be used to store this information.  

� Situation: The information cannot be stored in any of the standard infotype fields. 

� Procedure: Create a new infotype to meet your requirements using the infotype copy programs. 
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Creating Infotypes (Administration) - Step 1

SAP R/3
Infotype   Edit   Goto   Utilities   System   Help

Infotype no.
Dev. class

infotype

Subobjects

Module pool
PS structure

9nnn All

IT characteristics Techn. characteristics

Employee IT BothApplicant IT

User interface

Screen

Create Edit

Generate structures
Generate dialog mod.
Exit

1. Create and
activate all objects

Step 2

 
 

� Step 1: 

� You must store the infotype-specific fields of your infotype in the system. To do this, create structure 
PS9nnn in the Dictionary. 

y Make sure you create a structure, not a database table. 

y Save and activate your structure. 

y You might need new data elements and domains for your structure. 

 

 

 

 
                                         

 



© SAP AG HR530 3-11 

  SAP AG 1999

Creating Infotypes (Administration) - Step 2

View: Change IT Characteristics (Customizing): Details
Table view    Edit    Goto    Selection criteria    Utilities    Settings

infotyp
e

Screen number

General characteristics

Time cnstr.
table

Time
constraint

Customer infotype9nnn

Maint. aft. leave

2
Subty. table
Subtype obligatory

Subty. field
Subty. text tab.2

Display and selection

Select w/ end
Select w/ start

Select w/ date
Create w/o end
Create w/o start

List time period

New entries Var. list

2. Adapt screens
and maintain

tables

Step 1

 
 

� Step 2: 

� Call the infotype copy program for Personnel Administration (transaction PM01). 

y Enter a four-digit infotype number 9nnn in accordance with the PS9nnn structure that you created. 

y Create your new infotype. The infotype copy program creates the following objects automatically: 
- Database table PA9nnn 
- Structure P9nnn 
- Module pool: MP9nnn00 
- 3 screens (1000, 2000, 3000) for the module pool 
- Interface status 
- Dialog module (RP_9nnn) 

y When new infotypes are created, the following table entries are maintained automatically: 
- T777D Check Table for Infotypes 
- TDCD Dialog Modules 
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Creating Infotypes (Planning) - Step 1

Dictionary: Initial Screen
Dictionary object   Edit   Goto   Utilities   Environment   System

Database table
View

Table type
Structures

Data element

Domain
Search help
Lock object

Dictionary object

Display Change Create

1. Create and
activate structure

Step 2

Step 3

HRI9nnn

 
 

� Step 1: 

� You must store the infotype-specific fields of your infotype in the system. To do this, create structure 
HRI9nnn in the Dictionary. 

y Make sure you create a structure, not a database table. 

y Save and activate your structure. 

y You might need new data elements and domains for your structure. 

� If the data in your infotype has a repetitive structure (that is, you want to create a table infotype), you 
must also create structure PT9nnn for the table part of your infotype in the Dictionary. 
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Creating Infotypes (Planning) - Step 2

Dictionary: Initial Screen
Dictionary object   Edit   Goto   Utilities   Environment   System

Infotype
Infotype name

infotyp
e

Create Check

Type of infotype

Language-dependent infotype
Country-specific ITTable IT

Field IT

9nnn
2. Create infotype

(PPCI)

Step 1

Step 3

 
 

� Step 2: 

� Call the infotype copy program for Personnel Planning (transaction PPCI). 

� Enter a four-digit infotype number 9nnn in accordance with the HRI9nnn structure that you created. 

� When you create the infotype, you can choose between field infotypes and table infotypes. You can 
also determine whether your infotype is language-dependent and/or country-specific. 

� Create your new infotype. The infotype copy program creates the following objects automatically: 
- Database table HRP9nnn  - Module pool MP9nnn00  
- Table index  - 3 screens (1000, 2000, 3000) for the module pool  
- Structure P9nnn - CUA interface 
 - Dialog module (RH_INFOTYP_9nnn) 

� When new infotypes are created, the following table entries are maintained automatically: 
- T777D Check table for infotypes 
- T778T  Infotypes 
- T777T  Infotype texts 
- TDCT Dialog modules 
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Creating Infotypes (Planning) - Step 3

Screen Painter: Initial Screen
Screen   Edit   Goto   Utilities   Settings   Environment

Program
Screen number

Create

Test

Subobjects

Element list
Layout Editor

MP9nnn00

2000

Flow logic
Screen attributes

Infotype 9nnn

3. Adapt screens
and maintain

tables

Step 2

Step 1

 
 

� Step 3: 

� Adapt the new screens so that they meet your requirements. 

� Edit the layout, flow logic, and field attributes (modification groups). 

� Include MP9nnn20 enables you to define infotype-specific check modules in the flow logic. 

� The standard value set for the first modification group is 036. When you start report RHGROUP1 
with this value, you determine the functions (create, change, append, etc.) for which entries can be 
made in the appropriate field for this value. If you want to control input differently, use report 
RHGROUP0. It uses the function codes you selected to calculate the value for the first modification 
group.  

� Maintain the table entries that cannot be created automatically: 
- T777I  Infotypes per Object Type 
- T777Z Infotype Time Constraint 
- T77CD Infotypes - Customer-Specific Settings 
- T77NI Country assignment for national infotypes 

� To access these tables, choose Check from the infotype copy program for Personnel Planning, or 
choose the following customizing path: Human Resources Æ Organizational Management  Æ 
Infotype Maintenance Æ Maintain Infotypes. 
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Creating Infotypes - Summary

z Procedure used to create new infotypes - overview

R/3 Repository

ABAP/4
Module pool

PPCI/PM01

User interface Tables

Structure PS9nnn or
HRI9nnn

Screen 1000
Screen 2000

Screen 3000

 
 

� To summarize, there are three steps to creating customer infotypes: 

y Defining infotype-specific fields in structures PS9nnn and HRI9nnn in the Dictionary. 

y Creating core infotype objects using transactions PM01 and PPCI 
 (infotype copy programs for Personnel Administration and Personnel Planning). 

y Making customer-specific adjustments and controls. 
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Enhancing Infotypes - Overview

Contract type

Contract Elements (Infotype 0016)Contract Elements (Infotype 0016)

01

Contractual regulations

permanent
….

Continued pay 42

Payment period from beginning of illness

Sick pay suppl. 1
days
year

Probation 3

Deadlines

....

….

….
months

Contract type

Contract Elements (Infotype 0016)Contract Elements (Infotype 0016)

01

Contractual regulations

permanent
….

Continued pay 42

Payment period from beginning of illness

Sick pay suppl. 1

days
year

Probation 3

Deadlines

....

….

….
months

Customer-specific 1

Additional fields

Customer-specific 2
Customer-specific 3

 
 

� The enhancement concept for infotypes used in Personnel Administration, Recruitment, and 
Planning enables you to include any fields that you require in an infotype.  

� If you include additional fields in an infotype, they are processed the same way as fields in the SAP 
standard program during reporting, when infotype logs are created, when dynamic actions are 
performed, and so on. 

� Please note that enhancements are not the same as modifications. Enhancing an infotype in an SAP 
standard delivery system does not lead to problems when release upgrades are performed. 

� The following infotypes are excluded from the enhancement concept: 

y Infotype 0000 Actions 

y Infotype 0302 Additional Actions 

y Infotypes used in Time Management (2nnn) 

y Infotype 1000 Object 

y Infotype 1001 Relationships 
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Infotype Enhancement (Administration)

SAP R/3
Infotype   Edit   Goto   Utilities   System   Help

IT characteristics Techn. characteristics

Subobjects

CI include

Create

Infotype no.

Dev. class CL

Module pool

Include screen

Edit

All

infotype infotype infotype List scr.

Field name

ZZPERSA

ZZBUKRS

.......

Data element

PERSA

BUKRS

......

......

......

Name

Step 1:
create all
Step 1:

create all

Step 2:
create

and activate fields

Step 2:
create

and activate fields

CI_P0016

 
 

� Start the infotype copy program for Personnel Administration (transaction code PM01). This takes 
you to the Create Infotype screen. Choose Enhance IT. In the Infotype no. field, enter the four-digit 
number of the infotype you want to enhance. When you enter the infotype number, remember to 
include the leading zeros. 

� In the Subobjects box, select CI include and choose Create. This takes you to the following screen: 
Dictionary: Initial Screen. 

� Create the CI include and choose Activate. If you want to include fields that are completely new, you 
must also create data elements. Go back to the Enhance Infotypes screen. 

� Choose Create all. 

� Result: you have included additional fields in the standard single screen of an infotype. 
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Infotype  Edit  System  Help

Infotype
Infotype name

Infotype

Single
screen

1nnn

Infotype Enhancement (Planning)

Field name

ZZTEXT01

ZZTEST02

.......

Data element

TEXT01

TEXT02

......

......

......

Name

Step 1:
create all
Step 1:

create all

Step 2:
create

and activate fields

Step 2:
create

and activate fields

CI include

Create

Module pool

Include screen

Change

CI_P1003All

 
 

� Start the infotype copy program for Personnel Planning (transaction code PPCI). In the Infotype 
field, enter the four-digit number of the infotype you want to enhance. Choose Enhance.  

� This takes you to the Enhance screen. Choose Create all. This takes you to the following screen: 
Dictionary: Initial Screen. 

� Create the include and choose Activate. If you want to include fields that are completely new, you 
must also create data elements. Go back to the Enhance Infotypes screen. 

� Result: you have included additional fields in the standard single screen of an infotype. 

� Notes: 

y Infotypes 1000 (Object) and 1001 (Relationships) cannot be enhanced. 

y Before you enhance an infotype, find out whether it can be maintained directly (that is, using the 
detail maintenance transaction). If it can, there is no point in an enhancement. 
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Customer Infotypes: Summary

z You have learned which technical elements
constitute an infotype.

z You have learned how to create
new infotypes.

z You have learned how to enhance infotypes
included in the standard system by adding
your own fields.
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Exercises 

 
 

 
Unit: Customer Infotypes 
Topic: Creating an Administration Infotype 

 
 

• Create and activate the PS9nnn structure with data elements 

• Learn how to use transaction PM01 

• Maintain table T582A 

• Adapt the infotype single screen 

 
 

 
The HR Department at your enterprise wants to enter home work center 
data in the system for individual employees.  

 

1-1 Create an infotype “Home work center (##)” for Personnel Administration. Use 
infotype number 95##. (## = group number) 

1-1-1 The infotype should include the following fields: 
Field 1: COMP (full-time), new data element: ZCOMP##, domain: CHAR1_X. 

This field indicates whether the home work center is a full time one. 

Field 2: EQUI (equipment), new data element: ZEQUI##, domain: CHAR8. In 
this field you can store an abbreviation for possible equipment at the 
home work center. 

1-1-2 Maintain the infotype characteristics (T582A). You can copy the characteristics 
of infotype 0002. 

1-1-3 Use the Screen Painter to turn the "Full-time" field into a checkbox. 

1-1-4 Use HR Master Data Maintenance (transaction PA30) to test your infotype. 

1-2 (Optional) enhancement of the infotype’s structure logic for event PBO. 

1-2-1 In the Data Dictionary, create two new, client-dependent database tables 
ZZEQUI## and ZZEQUIT##. ZZEQUI## is for storing possible values of the 
Equipment field in your new infotype. In ZZEQUIT## you can store the 
corresponding language-dependent descriptive texts. In the table characteristics, 
select Table maintenance. 
 
Use the following field names and data elements: 
Field EQUI Data element ZEQUI## for the equipment abbreviation 
Field LANGU Data element LANGU for the language key 
Field EQUITXT Data element TEXT40 for the descriptive text 

 

 
                                         

 



© SAP AG HR530 3-21 

1-2-2 Maintain all the required foreign key relationships in your new structures and 
tables. 

1-2-3 In the Data Browser (transaction SE16), create a few example entries for your 
new tables. 

1-2-4 Activate the foreign key check for the Equipment field on the detail screen of 
your new infotype. 

1-2-5 Change the detail screen of your new infotype so that not only the equipment 
field appears, but also the corresponding descriptive text. 

1-2-6 Test your enhancement in HR Master Data Maintenance. 

1-3 (Optional) enhancement of the infotype’s structure logic for event PAI. 

1-3-1 Enhance the structure logic of your infotype’s detail screen in such a way that 
particular home work center equipment can only be entered for employees of 
particular personnel subareas. 

1-3-2 Test your enhancement in HR Master Data Maintenance. 
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Exercises 

 
 

 
Unit: Customer Infotypes 
Topic: Creating a Table Infotype 

 
 

• Create and activate the necessary structures for Personnel Planning 
infotypes 

• Learn how to use transaction PPCI 

• Maintain tables T777I and T777Z 

 
 

 
For work center planning you need data relating to the size of offices and 
the equipment in them. You must be able to store this data in the system. 

 

2-1 Create an infotype “Office equipment ##” as a table infotype for Organizational 
Management. Use infotype number 96##. (## = group number) 

2-1-1 The non-table part of the infotype should contain the following fields: 
Field 1: AREA, new data element: ZAREA##, data type DEC, length 8, 2 

decimal places. In this field you should be able to store the size (area) 
of an office. 

Field 2: NWORK (number of work centers), new data element: ZNWORK##, 
data type DEC, length 5, no decimal places. This field is for storing the 
maximum number of work centers in one office. 

2-1-2 The table part of the infotype should contain the following fields: 
Field 1: SNWRK (work center number), new data element: ZSNWRK##, data 

type DEC, length 5, no decimal places. This field contains a sequential 
number of work centers in an office. 

Field 2: EQUI (equipment), data element: ZEQUI## from the previous exercise. 
This field contains an abbreviation for a work center’s equipment. 

2-1-3 Enhance the Organizational Management data model in such a way that you can 
maintain the new infotype for the object type ## (office ##) that you created in 
the exercise following the “Data Structures in HR” unit. If you did not create 
that object type, use object type O (organizational unit). 

2-1-4 Test your new infotype in Expert Mode in Organizational Management. 
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Solutions 

 
 

 

Unit: Customer Infotypes 
Topic: Creating an Administration Infotype 
 

Notes:  

• Create all development objects as local objects.  

• You must activate the objects before you can test what you have created. 

1-1 Access transaction PM01, and enter the number 95## in the Infotype no. field. (## = 
group number) 

1-1-1 Select PS structure and choose Create. This takes you automatically to structure 
maintenance in the Data Dictionary. In the Short text field, enter the name of 
your infotype, for example Home work center ##. In the Component column, 
enter the field names. In the Component type column, enter the data element 
names. 
Field 1: Name: COMP, data element: ZCOMP## 

Field 2: Name EQUI, data element: ZEQUI## 

Creating the data elements: 

Double click on the data element names to access create mode for component 
types. A dialog box appears. Choose Data element. 

Enter meaningful short texts for your data elements. Enter the name of the 
domain that is referenced – CHAR1_X or CHAR8. Maintain field labels, and 
documentation if required.  

Save and activate both data elements. 

Save and activate the structure. 

Go back (Function F3) to the Create Infotype transaction, and choose Create 
all. 

1-1-2 Maintain the infotype characteristics (T582A) by copying the characteristics of 
infotype 0002. In the copied entry, correct the name of the infotype and the time 
constraint. The correct time constraint for your infotype is 2. 

1-1-3 Changing the Full time field to a checkbox: In the Create infotype transaction, 
under Subobjects, select Screen and enter the number 2000. Choose Edit. That 
takes you to the Screen Painter. Choose Change and then choose Layout. Use 
the graphical layout editor. You can choose it under Utilities → Settings. Select 
the field and field text for COMP, and choose Edit → Convert → Checkbox → 
Left button. Save and activate the screen. 
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1-1-4 Testing the new infotype: Access HR Master Data Maintenance (transaction 
PA30), enter any existing personnel number (for example 1000). In the Infotype 
field, enter the number of your infotype (95##) and choose Create. Create any 
data you like, save it, and test the various functions in HR Master Data 
Maintenance, for example Change, Copy, Delimit, Delete... 

1-2 (Optional) enhancement of the infotype’s structure logic for event PBO. 

1-2-1 Creating the new database tables: Access the ABAP Dictionary either by 
entering transaction code SE11 or by following the SAP menu path: Tools → 
ABAP Workbench → Development → ABAP Dictionary. On the initial screen, 
select Database table, enter the name, and choose Create. Enter a short 
description. The delivery class is C (customizing table). Select Table 
maintenance allowed.  
Choose Technical Settings and maintain the Logical storage parameters. In the 
Data class field, enter the value APPL0. In the Size category field, enter the 
value 0. Leave the screen by choosing Back (F3). 
 
On the Fields tab page, in the Fields column, enter the field names. In the Field 
type column, enter the data element names. Select the Key column for key 
fields. 
 
Table ZZEQUI##: 
 
Field MANDT Data element MANDT  Key field 
Field EQUI Data element ZEQUI## Key field 
 
Table ZZEQUIT## 
 
Field MANDT Data element MANDT Key field 
Field EQUI Data element ZEQUI## Key field 
Field LANGU  Data element LANGU Key field 
Field EQUITXT Data element TEXT40 
 

1-2-2 You can maintain the foreign key relationships for fields in structures and tables 
by choosing Goto → Foreign key(s). Before you do that, select the row 
containing the field for which you want to store a foreign key.  
The following foreign key relationships are required: 

1-2-2 a) Structure ZZEQUI##, field MANDT: 
 
Check table: T000 
Check table Check table field Foreign key table Foreign key field 
T000 MANDT ZZEQUI## MANDT 
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1-2-2 b) Structure ZZEQUIT##, field MANDT: 
 
Check table: T000 
Check table Check table field Foreign key table Foreign key field 
T000 MANDT ZZEQUIT## MANDT 
 

1-2-2 c) Structure ZZEQUIT##, field EQUI 
 
Check table: ZZEQUI## 
Check table Check table field Foreign key table Foreign key field 
ZZEQUI## MANDT ZZEQUIT## MANDT 
ZZEQUI## EQUI ZZEQUIT## EQUI 
 

1-2-2 d) Structure ZZEQUIT##, field EQUI 
 
Check table: T002 
Check table Check table field Foreign key table Foreign key field 
T002 SPRAS ZZEQUIT## LANGU 
 
Under Semantic attributes, select Key fields of a text table. 
 

1-2-2 e) Structure PS95##, field EQUI 
 
Check table: ZZEQUI## 
Check table Check table field Foreign key table Foreign key field 
ZZEQUI## MANDT SYST MANDT 
ZZEQUI## EQUI PS95## EQUI 
 

1-2-3 In the Data Browser (transaction SE16), create a few example entries for your 
new tables. 

1-2-4 Activate the foreign key check for the Equipment field on the detail screen of 
your new infotype. 
To edit the screen, choose the Object Navigator of the ABAP Development 
Workbench (transaction SE80). The name of the program in which your screen 
was created is MP95##00. Select screen 2000 and choose Layout in change 
mode. Go to the Element attributes for field P9500-COMP, by choosing Goto 
→ Secondary window → Element list, and select Foreign key. 

1-2-5 Change the detail screen of your new infotype so that not only the equipment 
field appears, but also the corresponding descriptive text. 

1-2-5 a) At the beginning of the PBO module P95##, insert the following lines of 
ABAP code:  
 
select single * from zzequit## where equi  = p9500-equi 
                                 and langu = sy-langu. 

1-2-5 b) In Include MP95##10, insert the following lines of ABAP code: 
 
tables zzequit##. 
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1-2-5 c) In the layout of screen 2000, insert the field ZZEQUIT##-EQUITXT. To do 
that, access the Screen Painter for the screen, go into the Layout Editor, and 
choose Goto → Secondary window → Dict/Program fields. Enter the table 
name ZZEQUIT##, choose Get from Dictionary, select the row with the 
EQUITXT field, and Enter the field Without text. You can now use the mouse 
to position the field on the screen.  

1-3 (Optional) enhancement of the infotype’s structure logic for event PAI. 

1-3-1 Enhance the structure logic of your infotype’s detail screen in such a way that 
particular home work center equipment can only be entered for employees of 
particular personnel subareas. 

1-3-1 a) In the structure logic of screen 2000 for event PAI, insert the following lines 
after the PRE_INPUT_CHECKS module: 
 
field p9500-equi module p95##_checks. 

1-3-1 b) Double click on p95##_checks to create this new PAI module. Create it 
with the following lines of ABAP code in Include MP95##30: 
 
MODULE p9500_checks INPUT. 
  if   p9500-equi  = 'ABAKUS' and 
       not ( psyst-werks = 'CABB' and 
             psyst-btrtl = '0001'). 
    message e855(rp). 
  endif. 
ENDMODULE. 
 
This coding specifies that equipment “ABAKUS” is only permitted for 
employees in personnel area “CABB” and personnel subarea “0001”. You can 
test this example data using personnel number 540991##. If you wish, you can 
use other example data instead. 
 
Note: This example was only written for the purpose of the exercise. In reality, 
it is not advisable to program a query involving concrete values (“ABAKUS”, 
“CABB”, “0001”), since if the values changed, you would also have to change 
the program. Instead, use variables that, for example, contain the check values 
read from the database. In the current example, you could use another database 
table, in which the permitted equipment for each personnel area and subarea is 
stored. 
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Solutions 

 
 

 

Unit: Customer Infotypes 
Topic: Creating a Table Infotype 
 

2-1 Create an infotype “Office equipment (##)” as a table infotype for Organizational 
Management. Use infotype number 96##. (## = group number) 

2-1-1 Creating a structure for the non-table part of the infotype: 
Access the Data Dictionary, and create a new structure with the name HRI96##. 
Use the following field and data element names: 
AREA Data element ZAREA## 

Data type DEC, length 8, 2 decimal places. 

NWORK  Data element ZNWORK## 
Data type DEC, length 5, no decimal places. 

Creating the data elements: 

Double click on the data element names to access create mode for component 
types. A dialog box appears. Choose Data element. 

Enter meaningful short texts and field labels for your data elements. In the data 
type information, choose Built in type, and use the above-mentioned entries. 

Save and activate both data elements. 

Save and activate the structure. 

2-1-2 Creating a structure for the table part of the infotype: 
Access the Data Dictionary, and create a new structure with the name PT96##. 
Use the following feld and data element names: 
SMWRK Data element ZSNWRK## 

Data type DEC, length 5, no decimal places. 

EQUI Data element ZEQUI##  
already exists from the “Creating an Administration Infotype” 

Create a data element ZSNWRK as described in 1-1-1. 

Save and activate the new data element. 

Save and activate the structure. 

Access transaction PPCI. Enter the infotype number 96##, and the name “Office 
Equipment ##”. Choose Create. On the next screen, in the Infotype type section, 
choose Table infotype and then Create. 
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2-1-3 Enhance the Organizational Management data model in such a way that you can 
maintain the new infotype for the object type ## (office ##) that you created in 
the exercise following the “Data Structures in HR” unit. 
 
You have two alternatives: Access the tables either through the IMG, as 
described in the exercise following the “Data Structures in HR” unit, or from 
the generating transaction (PPCI). The second alternative is described below: 
Choose Check. A log appears. Position the cursor on line T7771 ... in the Table 
entries section, and choose Change. Access table maintenance, and for infotype 
96## maintain a new Time constraint entry with the following values: 
 
Object type:  ## 
Infotype: 96## 
Subtype:  
Time constraint: 2 
 
In addition, maintain a new entry under Infotypes per object type with the 
following values: 
 
Object type:  ## 
Infotyp: 96## 
 

2-1-4 Test your new infotype in Expert Mode in Organizational Management. 
Access transaction PP01, or go to the SAP menu and choose Human Resources 
→ Organizational Management → Expert Mode → General. Choose the plan 
version “Current plan” and the object type “Office (##)”. Select an object by 
choosing F4 help for the Object ID field, or create a new object. In the table of 
infotypes, choose your infotype “Office equipment ##”, and create an infotype 
record. Test further functions in this transaction. 
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Enhancement Options

z Enhancing the infotype maintenance dialog

z Displaying additional data in simple maintenance 
for the organizational plan

z Enhancing Manager´s Desktop with 
customer-specific functions

z Workflow: triggering events when infotypes
are updated

Contents:
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At the conclusion of this unit, you will be able to:

z Describe the most important enhancement 
and configuration options used in Personnel 
Administration and Organizational Management.

Enhancement Options: Unit Objectives
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Introduction

Data Structures in HR

Customer Infotypes

ALE, Transport Link, and Data Transfer

Creation of Infotype Logs, Logging, and Archiving

Enhancement Options

Course Overview Diagram
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Enhancement PBAS0001

Maintain 
HR master 

data 
(initial screen)

z Create, 
copy 
infotypes

z Enter data

Save

Functions for process 
without active user exit:

Functions for process 
with active user exit:

z Additional default 
values

z Additional checks

z Standard default
values

z Standard checks

 
 

� The general SAP enhancement concept enables customers to enhance application logic, screens, and 
menus with their own elements.    

� Function exits allow customers to implement additional logic in a transaction. The SAP application 
developer determines where function exits can be accessed within a transaction, and which data is 
transferred. He or she creates the appropriate function modules together with a short text, interface, 
and documentation. 

� The general procedure for activating a function exit consists of the following steps:  

y Create enhancement project 

y Select SAP enhancement 

y Edit enhancement components (that is, enter customer-specific code) 

y Activate and transport project 

� Enhancement PBAS0001 has two function exits.  

y Function exit EXIT_SAPFP50M_001 allows customer-specific defaults to be entered in a single 
screen when infotypes are created or copied. 

y Function exit EXIT_SAPF50M_002 allows an additional customer-specific check to be performed 
after data has been entered in a single screen and the fields have been validated. 
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Change staff assignmnt

 IDES AG IDES AG
 Executive Board: Germany

 Executive Board: Portugal

 Executive Board: Belgium
 Executive Board: USA

 CEO
 Board for Financials
 Board for Production
 Board for HR

Organizational plan ...      View   System   Help

Relationship text on
Abbreviation on
Addit'l info on/off
...  Valuation group

 Group A
 Group B
 Group B
 Group B

Menu exit for 
additional 

menu option

Function exit 
for header

Function exit for
additional info

Function exit for 
function to be executed

SAP Enhancements in the Organizational Plan

 
 

� The structure maintenance screen in Organizational Management enables you to show additional 
information on each structure object. 

� Simple maintenance of the organizational plan and reporting structure is supported by SAP 
enhancement RHGB0001. It consists of several components: 

y Two menu exits that enable you to show an additional menu option in the View menu of the 
maintenance screen for the organizational plan and reporting structure.  

y A function exit that is accessed when the user selects the new menu option. This function is 
normally used to hide or show additional information. 

y A function exit that is used to determine the text to be displayed for each structure object, and its 
format. 

y A function exit that is used to determine the header for additional information, and its format. 

� SAP enhancement RHGP0001 is created in the same way as enhancement RHGB0001. This 
enhancement enables you to show additional information in General Structure Maintenance. 

� SAP enhancement RHSI0001 enables you to show the additional information determined by 
enhancement RHGB0001 in the view for Account Assignment and Further Characteristics. 
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Manager's Desktop: Overview

z Broad range of functions specifically intended to help 
managers perform their tasks (for example, functions 
from various components, workflow inbox, Internet 
connection, etc.)

z User-friendly and intuitive

z Customizing steps and user-specific settings allow
functions to be arranged exactly as required

z Customer reports can be included

Helps managers to perform their 
administrative and planning tasks
Helps managers to perform their 
administrative and planning tasks

 
 

� SAP Manager´s Desktop is tailored to the daily needs of managers - line managers, for example - by 
helping them to perform their administrative, organizational, and strategic tasks. The Manager's 
Desktop concept is to support the growing trend of decentralizing Human Resource tasks and 
responsibilities.  

� Manager's Desktop helps managers to make Human Resource decisions and perform strategic 
planning activities by providing them with swift access to required HR data of directly and indirectly 
subordinate employees. It then enables them to report on this data. 

� Managers can use Manager's Desktop to perform cross-application functions. For example, they can 
execute workflow tasks (work items), or use reports to access data stored in Accounting or 
Controlling. Manager's Desktop can be used to execute a wide range of standard reports from Human 
Resources and Controlling, as well as customer reports. Its web browser integration means that 
Manager's Desktop also enables managers to display intranet and Internet pages. 

� New functions, such as drag and drop, make Manager's Desktop particularly easy to use.   
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Manager's Desktop: Initial Screen

Theme categories Function list

z Ad Hoc Query
z Reports
� Pers. Admin.
� Time Data
�  .…

z Profile
z .…
z .…z Bonus plan

z Salary adjustment
z Extraordinary

salary adjustments

z Adaptable theme and function catalog
z User-specific selection of theme 

categories and functions
z Enterprise-specific initial screen possible 

(background picture and enterprise logo)

z Adaptable theme and function catalog
z User-specific selection of theme 

categories and functions
z Enterprise-specific initial screen possible 

(background picture and enterprise logo)

z Employee data

z Organization

z Compensation

z Workflow inbox

z Special areas

 
 

� The initial screen provides an overview of the default main scenario in Manager's Desktop (MDT), 
which consists of the five theme categories listed above and their function lists. 
The function codes in Customizing can be used to put these categories into customer-specific 
hierarchies. The categories can also be enhanced with customer-specific functions. 

� Furthermore, the user can deactivate unnecessary categories and functions on the initial screen and 
on the various screens of the different application components. It is always possible to switch 
between user settings and standard settings. 

� The initial screen can be adapted to customer-specific requirements in Customizing. For example, it 
can be enhanced with an enterprise logo and/or background picture. 
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Function codes for Manager's Desktop

Transaction code
Function module
Program name
Variant name
WEB address (URL)

Function code
Text
Type

Object type specific
Org. structure based

URL  WEB address (URL) 
URLW WEB address (URL) w/o navigation
FUNC Function module
REPO Report
RWRP RW report (cost accounting)
TCOD Transaction code
NODE Node that cannot be executed
HOME Root node 
INBX Workflow inbox 
COPL Cost center planning
BWRP BW-Reports (Web-Reporting)
BWEX BW-Reports (Excel)

IMG: Table T77MWBFCD

MDT: Add Additional Functions

 
 

� You can include additional functions in the Manager's Desktop menu. 

� The functions can be of different types - this depends on how the accessed function works. 

� You can access Internet and/or intranet pages, start reports and transactions, or access ABAP 
function modules. 

� When reports that use HR logical databases (PNP, PCH, PAP) are accessed, they are provided 
automatically with the objects selected by the user. The selection screen is skipped.  

� Example: You have included additional fields in the Personal Data infotype, and written a report on 
the basis of logical database PNP to report on these fields. You can offer this report as a function in 
Manager's Desktop. In staff assignments in Manager's Desktop, the user then chooses the people for 
whom the report is to be started. The report selection screen is not displayed. 

� Entries of the type HOME and NODE are simply part of the structure of the menu tree, and do not 
provide any executable functions. 

� You can see these settings in the SAP Implementation Guide, under Personnel Management -> 
Manager's Desktop -> Enhancement of Function Codes 
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FUNCTION Z_CUSTOMER_FUNCTION_1 
*"*"Local interface:
*"  IMPORTING
*"     VALUE(ACT_FCODE) TYPE  MWB_FCODE
*"     VALUE(ACT_PLVAR) TYPE  PLVAR
*"     VALUE(ACT_OTYPE) TYPE  OTYPE
*"     VALUE(ACT_OBJID) TYPE  REALO
*"     VALUE(ACT_BEGDA) TYPE  BEGDATUM DEFAULT SY-DATUM
*"     VALUE(ACT_ENDDA) TYPE  ENDDATUM DEFAULT '99991231'
*"  EXPORTING
*"     VALUE(ACT_PROGNAME)  LIKE SY-REPID
*"     VALUE(ACT_PROGNAME)  LIKE SY-DYNNR
*"  TABLES
*"      ACT_OBJECTS STRUCTURE  HRSOBID

*"  EXCEPTIONS *" *"     FCODE_NOT_VALID FCENDFUNCTION.

FUNCTION Z_CUSTOMER_FUNCTION_1 
*"*"Local interface:
*"  IMPORTING
*"     VALUE(ACT_FCODE) TYPE  MWB_FCODE
*"     VALUE(ACT_PLVAR) TYPE  PLVAR
*"     VALUE(ACT_OTYPE) TYPE  OTYPE
*"     VALUE(ACT_OBJID) TYPE  REALO
*"     VALUE(ACT_BEGDA) TYPE  BEGDATUM DEFAULT SY-DATUM
*"     VALUE(ACT_ENDDA) TYPE  ENDDATUM DEFAULT '99991231'
*"  EXPORTING
*"     VALUE(ACT_PROGNAME)  LIKE SY-REPID
*"     VALUE(ACT_PROGNAME)  LIKE SY-DYNNR
*"  TABLES
*"      ACT_OBJECTS STRUCTURE  HRSOBID

*"  EXCEPTIONS *" *"     FCODE_NOT_VALID FCENDFUNCTION.

Key of selected 
object

Function code for function
 triggered in MDT

Screen to be accessed
(optional)

Table with keys of 
selected objects

Function code
Text
Type

Z_CUST1
Customer function 1
FUNC

IMG: Table T77MWBFCD

Function module Z_CUSTOMER_FUNCTION_1

ABAP

Selection period 
set in MDT

MDT: Insert Function Module

 
 

� Function type FUNC enables you to configure Manager´s Desktop so that it can be used to access 
any functions that you developed. In this instance, you use Customizing to store the name of a 
function module that you created for the pertinent function code. When the user selects the function 
in Manager's Desktop, the function module is accessed. 

� The interface for such function modules is determined by SAP. This interface provides you with the 
following information: the function code that was triggered, the object that is currently selected, and 
the objects that are currently flagged. Furthermore, the selection period specified in Manager's 
Desktop is transferred to the function module. 
Using the module's export parameters - ACT_PROGNAM and ACT_SCREEN_NO - you can 
specify that a screen is to be displayed in Manager's Desktop. 
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Successful workflow management means 
providing employees at the appropriate time with 

suitable tasks and relevant information

Workflow in One Sentence

 
 

� SAP Business Workflow relates the following four aspects of a process to each other: 

y Organizational plan (Who?) 

y Process structure (When? In what order? Under what conditions?) 

y Function (What?) 

y Information (Which data is used?) 

This ensures that business processes are executed as efficiently as possible. 

� The process to be represented as a workflow is stored in the system with parameter settings. A 
graphical definition tool is used to do this. When the workflow runs, the workflow manager - that is, 
the R/3 System - performs all of the tasks that could be anticipated when the process was defined. As 
a result, users are not required to perform avoidable organizational activities, and can concentrate on 
other aspects of their work instead. 
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Organization

Processes

Business
objects

Person Position/job Org. unit

Task

WF definition
 Data

Step

 Data

Reference

Attribute
s

Object

MethodsEvents

Access and
results

Change of
status

Read access

RoleRole

Human
Resources

Workflow Management Architecture

 
 

� SAP Business Workflow is characterized by its three-level architecture. The modular design of its 
components provides the basis required for a high degree of flexibility. 

� The Business Object Repository is situated on the lowest level. It contains a definition of all of the 
business objects and their methods, attributes, and events that can be used in workflow definitions. 
R/3 functions, such as hiring employees, are accessible via business objects. 

� The order in which tasks are executed, and the rules used to determine how tasks are executed, are 
defined on the process level. Each task is represented by a step in workflow. Object data and 
information added during the process are forwarded from step to step, or are available to agents 
during the entire workflow procedure. Process control facilitates the sequential, parallel, alternative, 
and hierarchically nested execution of steps.  

� The organizational level provides information on responsibilities and the personnel structure of the 
enterprise. This ensures that tasks are forwarded to the right agents during runtime. 
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Who
from?

Role

Desktop
application

SAP
functions

External
applications

Definition time
Multistep task

Workflow
definition
WorkflowWorkflow
definitiondefinition

Single-step 
task

Single-step Single-step 
tasktask

MethodMethodMethod

Object type

Organizational
plan

Workflow: Design and Process I

 
 

� The workflow definition contains the business process. The event-driven process chain (EPC) is 
used to describe it. Single-step tasks constitute the most important elements of the workflow 
definition.  

� Single-step tasks 

y Represent SAP functions from a business perspective 

y Each one uses just one method 

� SAP Business Workflow is based on object-oriented design.  
Objects are defined in the Object Repository, which is supplied by SAP. Object methods 

y Represent SAP functions from a business object perspective 
(technical view, such as create, delete, change) 

y Provide a standard, transparent interface for SAP functions 
(transactions, function module, report, ...) 

y Encapsulate functions 

� The agents responsible for an activity in workflow are defined by an assignment to an object in the 
organizational plan, or by a role. Roles are used to determine responsible agents dynamically - that 
is, depending on the information that is first available during workflow runtime. 
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Workflow manager

Work item manager

When?
In what order?
By when?

Who
from?

Role

Desktop
application

SAP
functions

External
applications

What?

Definition time Runtime

Execution of
object method
Execution ofExecution of

object methodobject method

Work itemWork itemWork item

WorkflowWorkflowWorkflow

Integrated
inbox

execute
display
forward

Multistep task

Workflow
definition
WorkflowWorkflow
definitiondefinition

Single-step 
task

Single-step Single-step 
tasktask

MethodMethodMethod

Object type

Organizational
plan

trigger event

Data-
base

Workflow: Design and Process II

 
 

� Workflows are usually started by a triggering event. Events are used to publicize changes to the 
status of objects in the system. Like methods, they are defined in the Object Repository for each 
object type. An event is triggered in an application. 

� Example: The workflow used to approve an absence is started when the act of saving an absence 
notification triggers the requested event of the absence object type. 

� Work items are the runtime representation of a single-step task. They are assigned by the workflow 
manager to the agents responsible.  

� When an agent accepts a work item for processing, it disappears from the inboxes of other agents. 

� When a work item is executed, its object method is accessed. 
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BASICPAY
requested

Workflow: Creating Events When Infotypes Are
Updated

Save

Data is updated in 
infotype database tablesInfotype maintenance in HR T77S0: control parameters

? 

T779W/T779X: assignment of event to HR object type, infotype, subtype, update operation

T777IBO: assignment of business object type to HR object type, infotype, subtype

WORKF ACTIV X

0008 BASICPAYP

0008 BASICPAYP REQ

Update task publicizes the event

R

Custo
mer

Update task reads

REQUESTED

 
 

� Events used to publicize changes in the status of HR infotypes are created when infotypes are 
updated. 

� The prerequisite is that event creation has been activated in control table T77S0 (entry WORKF 
ACTIV = X). 

� Table T779W (SAP) or T779X (customer) contains the event to be created. Table T777IBO contains 
the assignment of business object type to HR object type, infotype, and subtype.  

� By specifying a function module, you can ensure that additional checks are performed before an 
event is created. The triggering event can be determined dynamically. 

� You can maintain these tables by performing activities in the Implementation Guide. To access these 
activities, choose Personnel Management -> Personnel Administration -> Tools -> Business 
Workflow events. 

 

 
                                         

 



© SAP AG HR530 4-15 

  SAP AG 1999

HR_EVENT_RULES_PA0001HR_EVENT_RULES_PA0001

Comparison of changes made to an infotype record:

BEFORE_IMAGEBEFORE_IMAGE AFTER_IMAGEAFTER_IMAGE

Function module template for Planning infotypes

Function module template for Administration infotypes

Change infotype xy

Field C

Field A Field B

ASDF

Change infotype xy

Field C

Field A Field B

qwerty

HR_EVENT_OT_NNNN_UUUU_TEMPLATEHR_EVENT_OT_NNNN_UUUU_TEMPLATE

Workflow: Dynamic Generation of Events

 
 

� You can determine that events are created dynamically, that is, at runtime. To do so, enter a function 
module that you programmed in table T779X, instead of an event. This function module is accessed 
by the update task, can perform additional checks, and then returns the triggering event to the update 
task. 

� SAP provides you with function module templates, one for infotypes in Personnel Administration 
and one for infotypes in Personnel Planning. Copy the template to your namespace, and use the new 
function module to store the checks you want to perform. 

� The function module interface provides you with the BEFORE_IMAGE and AFTER_IMAGE 
parameters. They contain infotype data before and after it is processed by a user in infotype 
maintenance. By comparing these two parameters, you can determine - for example - that an event is 
only triggered if the data stored in a particular field is changed. 
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z You have learned how to include 
additional default values and checks 
in infotype maintenance.

z You have learned how to display 
additional data in simple maintenance.

z You have learned how to include
additional functions in Manager´s Desktop.

z You have learned how events are 
triggered in HR for SAP Business
Workflow.

Enhancement Options Summary
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Exercises 

 
 

 

Unit: Enhancement Options 
Topic: Manager’s Desktop 

 
 

At the conclusion of these exercises, you will be able to: 

• Include additional functions in Manager’s Desktop. 

 

 
 

You want to include additional functions in Manager’s Desktop for the 
managers at your company.  

1-1 Select any report from Personnel Administration, and make it available in Manager’s 
Desktop. The corresponding function must appear in a separate branch. In the same 
branch, provide your head of department with a link to a website of your choice. Test 
whether your settings provide the intended result. 

1-2 (Optional) In the same branch in Manager’s Desktop, provide a new function that 
allows the user to display personnel time data (transaction PA51) for a selected person. 
Set the function so that it is only possible if a person has been selected. 
 
With which function type must the new function code be created? 
 
If you want to program a function module, you must also create a function group. You 
can use the following naming conventions: 
Function group:  ZHR530_## 
Function module: ZHR530_##_MDT 

Tip: You need the ABAP command SET PARAMETER ID. The user parameter for 
personnel numbers is PER. 

 

 

 
                                         

 



© SAP AG HR530 4-18 

Solutions 

 
 

 

Unit: Enhancement Options 
Topic: Manager’s Desktop 

1-1 Including additional functions in Manager’s Desktop. 

1-1-1 a) Access the SAP Implementation Guide by choosing Tools → 
AcceleratedSAP → Customizing → Project Management → SAP Reference 
IMG. In the IMG, choose Human Resources → Manager’s Desktop → 
Enhancement of Function Codes → Wizard for Defining Function Codes. 
 
Execute the individual steps in the wizard. Create the new function codes in the 
“Special Areas” theme category. Name the function codes, for example,  
 
Z_##N for the subcategory 
Z_##R for calling a report, and 
Z_##U for a Web address. 
 
## is your two-digit group number.  
 
For function code Z_##R, choose the function type Report, and enter the name 
of any Personnel Administration report, such as RPLMIT00, in the Program 
name field. For function code Z_##U, use the navigation buttons to choose 
function type WWW address, and enter the name of any page in the World 
Wide Web, such as www.sap.com, in the WEB address (URL) field. 

1-1-2 Testing the settings: Assign your user to the chief position of any organizational 
unit, or maintain infotype 0105 Communication, subtype 0001 for a person who 
has a chief position. Access Manager’s Desktop. Have your functions been 
included? Do they provide you with the result that you require? 

1-2 Calling up personnel time data from Manager’s Desktop. 

1-2-1 Bad solution: In Manager’s Desktop you include a new function that you define 
with the function type Transaction. Enter PA51 as the transaction code. The 
disadvantage of this solution is that the personnel number of the selected person 
is not transferred to the transaction, but must be entered separately. 

1-2-2 Good solution: In Manager’s Desktop you include a new function that you 
define with the function type Function Module. You can call this function code 
Z_##F, for example. Use the wizard again. 
Before you do that, you must create a new function group, and within it a 
function module with the interface determined by SAP, which takes data from 
Manager’s Desktop and calls transaction PA51. The personnel number is 
transferred to the transaction via the SET/GET parameter PER. 
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1-2-3 a) Create a new function group, Z_HR530##. To do this, call the Object 
Manager of the ABAP Development Workbench (transaction SE80). At the top 
left of the screen, choose Function group, and enter Z_HR530_## in the field 
underneath. Choose enter. You can now create the function group. 

1-2-3 b) Create a new function module by positioning the cursor on the object name 
of the function group (Z_HR530_##), holding down the right mouse button and 
choosing Create → Function module. Enter the name Z_HR530_##_MDT and 
a short text. 
Maintain import, export, and table parameters, and the source text as shown in 
the following ABAP lines: 
 
 
FUNCTION Z_HR530_00_MDT. 
*"--------------------------------------------------------
---- 

*"*"Local interface: 

*"  IMPORTING 

*"     VALUE(ACT_FCODE) TYPE  MWB_FCODE 

*"     VALUE(ACT_PLVAR) TYPE  PLVAR 

*"     VALUE(ACT_OTYPE) TYPE  OTYPE 

*"     VALUE(ACT_OBJID) TYPE  REALO 

*"     VALUE(ACT_BEGDA) TYPE  BEGDATUM DEFAULT SY-DATUM 

*"     VALUE(ACT_ENDDA) TYPE  ENDDATUM DEFAULT '99991231' 

*"  EXPORTING 

*"     VALUE(ACT_PROGNAME)  LIKE SY-REPID 

*"     VALUE(ACT_PROGNAME)  LIKE SY-DYNNR 

*"  TABLES 

*"      ACT_OBJECTS STRUCTURE  HRSOBID 

*"--------------------------------------------------------
---- 

 

  IF act_objid IS INITIAL. 

    READ TABLE act_objects WITH KEY otype = act_otype. 

    IF sy-subrc = 0. 

      act_objid = act_objects-sobid. 

    ENDIF. 

  ENDIF. 

 

  SET PARAMETER ID 'PER' FIELD act_objid. 

  CALL TRANSACTION 'PA51'. 

 
ENDFUNCTION. 
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ALE, Transport Link, and Data Transfer
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ALE, Transport Link, and Data Transfer: Unit
Objectives

At the conclusion of this unit, you will be able to

z Define the basics of ALE distribution in HR.

z Use the transport link for Planning infotypes.

z Apply the techniques used to transfer data to
the HR System.

z Perform steps and apply utilities that ensure
the consistency of your data after transfers
and transports.
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Introduction

Data Structures in HR

Customer Infotypes

ALE, Transport Link, and Data Transfer

Creation of Infotype Logs, Logging, and Archiving

Enhancement Options

Course Overview Diagram
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ALE and Decoupling of Human Resources

R/3

R/3R/3

HR

FI/LO 1 FI/LO 3

R/3

FI/LO 2

 
 

� ALE is the abbreviation for Application Link Enabling: 

� ALE is a technology that allows you to integrate business processes across system boundaries. 

� That means that while ALE itself does not bring any new functions to HR, it allows SAP HR to run 
in a separate - that is, decoupled - system.  Certain defined interfaces are provided to allow 
communication with the other R/3 components. 
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R/3

R/3

Central HR
Maintenance of

•HR Master Data, Plan Data

•HR Customizing Data

•HR Transaction Data

FI/LO 1 FI/LO n

R/3
Separate FI/LO
•Duplicated HR Master Data/Plan Data
read access only
•Up to release 4.0: One FI/LO system
•From release 4.5: several FI/LO systems

Distributed HR: "HR Only" Scenario

 
 

� Decoupling of HR is possible in a limited way from release 3.1H, almost completely from release 
4.0B, and completely from release 4.5B. In addition, from 4.5B it is possible to couple an HR system 
with several Accounting/Logistics systems.  

� When the HR system is coupled with several Accounting/Logistics systems, the receiver system is 
determined by filtering according to company code. 

� Scenarios supported (selection): 

y From release 3.1: Duplication of HR master data and plan data, personnel cost planning, sales 
personnel, posting of payroll results, posting of travel expense results, confirmations from 
PP/PI/PM/SM/PS 

y From release 4.0: Third party remittance, activity allocation Training and Event Management, 
Training and Event Management, activity allocation Time Management, capacity planning 

y From release 4.5: Wages in the construction industry, time sheet (CATS), link to external time 
management / time recording systems 

y When different releases are involved, the lowest release determines which scenarios are possible. 

 

 
                                         

 



© SAP AG HR530 5-6 

  SAP AG 1999

Duplication of Master Data

IDoc
Infotype 0000
Infotype 0001
Infotype 0002
Infotype 0003

...

Employee

Infotype 0000
Infotype 0001
Infotype 0002
Infotype 0003

...

Employee

Accounting
 

Payroll
results

Asynchronic Posting

BAPI

Synchronic Validation

Can I post to
cost center

xyz?

Yes!

BAPI

Return value

 Validation
 Validation

Transport from Customizing

T001
BUKRSMANDT ...

T001
BUKRSMANDT ...

SE10

001        0001
001        1000

090        0001
090        1000

Elements: Data Consistency and Synchronization

 
 

� Transport of Customizing data 

y Prerequisite for ALE: Identical Customizing in all systems involved 

� Duplication of master data using IDocs: For example HR Master Data, Organizational Plan, cost 
centers 

y IDoc = intermediate document 

y IDocs function as data containers, which are transferred by tRFC (transactional remote function 
call) 

y Initial distribution and distribution of data changes 

y Message type for each scenario 

� Synchronic coupling through BAPIs: For example reading the existence validation (for non-
duplicated data) 

y BAPI = Business Application Programming Interface 

y Special function modules that are called by RFC 

y If necessary, receiver determination by company code, controlling area 

y Object method for each scenario 

� Asynchronic coupling through BAPIs: For example, posting an HR Payroll result to Accounting 

y Automatic generation of IDocs in the background 

y Accessing the function module in the receiver system 
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HR_Stand_alone
HRPCLNT001

FI1CLNT001

BAPI
AcctngEmplyeeExpnses.Post
... BAPI

BAPI

Debitor.GetDetail

Sender: HR productive system
Receiver: FI productive system 1

Model view

FI2CLNT001

BAPI
AcctngEmplyeeExpnses.Post
... BAPI

BAPI

Debitor.GetDetail
Receiver: FI productive system 2

Filter, for example, for the BAPI AcctngEmplyeeExpnses.Post

Company code?

0001 0002

FI1CLNT001 FI2CLNT002

Customizing: The Distributed Model

 
 

� The distribution model defines which systems communicate with each other, and which ALE 
scenarios are applied. 

� So-called Model views group together parts of the distribution model that belong together for 
business or technical reasons, and that contain the settings for one or more ALE scenarios. 

� For each model view, the following are determined: 

y Logical sender and receiver system (logical system means the respective system / client 
combinations) 

y Message types and object methods (BAPIs) required for the ALE scenario being set up. (For more 
information, see the IMG documentation for the individual scenarios) 

y Data filtering and receiver determination 

� For ALE scenarios in HR, the program RHALEACU is available to automatically set up the 
distribution model 

� As an example, the model view above shows BAPIS and a possible filter definition for the Posting 
Payroll Results to Accounting scenario. 
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IDoc
Infotype 0000
Infotype 0001
Infotype 0002
Infotype 0003

...

Employee

Infotype 0000
Infotype 0001
Infotype 0002
Infotype 0003

...

Employee

Initial distribution:

Report RHALEINI

Change of
address
(infotype 0006)

Employee

IDoc

Update
Infotype 0006

Employee
Report
RBDMIDOC

DB
PA0006

Change pointers
PERNR INFTY SUBTY BEGDA  ...

Master Data Changes

HR Master Data Distribution: Procedure

 
 

� Initial distribution takes place via the program RHALEINI (transaction PFAL). You must select 
insert mode as your transfer mode. Update mode enables you to dispatch individual infotypes (see 
the information on change pointers).   

� After initial distribution, you must ensure that subsequent changes to master data remain consistent 
in all systems. If you change a master data object, and the changed infotypes are specified as relevant 
to ALE, the system writes a change pointer. 

y Change pointers are read using report RBDMIDOC, which is usually scheduled as a background 
job so that IDocs are created periodically (once a day, for example).  

y ALE does not write the actual changes. Instead, it writes information about the infotypes that were 
changed. Different changes to the same object are grouped together. 

y To display the change pointers, run report RHALECPS. It also shows you which infotype was 
changed. 

� Filtering: 

y SAP strongly recommends data filtering (network load, access protection for data) 

y You can filter according to object, infotype, or subtype 

y In the standard, it is not possible to filter according to other criteria such as company code. This 
can be achieved by using user exits 
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HR Master Data Distribution: Distributable Objects

Person infotypes, from 4.6C also applicant infotypes
z 0000, 0001, 0002, 0003 (HR mini master; required)

z 0006, 0009, 0017, 0105, 0900

z 0050, 0222, 0283 (from 4.0A)

z 0315 (from 4.5A)

z Many more infotypes from 4.6C (for complete list, see
transaction WE30)

Organizational Management
z All infotypes (10**)

z All objects apart from activity groups,
workflow, and responsibilities, that is, object
types X*, TS, T, WF, WS, RY

z Only within the same (active) plan version

z Tasks are not distributed, but their
relationships are.

 
 

� Support of other infotypes (also customer infotypes) 

� For further information on ALE and HR, see note 200066 
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Transport Link for Planning Infotypes

z Which types of transport link exist?

System 2

Object list
R3TR TDAT PDST

Key list
TABU HRP1000 100.:O 50000999*
TABU HRP1001 100O 50000999.:*
TABU HRP1002 100.:O 50000999*
...
TABU HRT1002 100SYS-----100A...
...
TABU HRPAD21 100SYS-----100A...
...
TABU PLOGI 100.:O 50000999*
...
TABU PLOGI_DEL 1000.:O 50000998*

z Automatic Transport Link

z Manual Transport Link

z Transport Using Object Lock

 
 

� Unlike data transfers, transport links mean the techniques for transporting data between different 
R/3 Systems. 

� There are three ways of transporting Planning infotypes: 

y Automatic transport 

y Manual transport 

y Transport using object lock 

� You can select a transport link in Customizing. IMG path: Personnel Management -> 
Organizational Management -> Transport. 

� Irrespective of the type of transport, data is always transported on an object-by-object basis. This 
means that all of the infotype records for the object to be transported are always written to the 
change request, or transported. 
You can also set an import lock in the target system to prevent specific objects from being 
overwritten by transported infotype records by mistake. 
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Request 
Key list
TABU HRP1000
TABU HRP1001
TABU HRP1002
...
TABU PLOGI
...
TABU PLOGI_DEL

Request 
Key list
TABU HRP1000
TABU HRP1001
TABU HRP1002
...
TABU PLOGI
...
TABU PLOGI_DEL

Requests of user

   Modifiable

      Transportable

         SY1K23..

Requests of user

   Modifiable

      Transportable

         SY1K23..

Automatic Transport Link

If Planning infotypes 
are created, changed, 
or deleted, objects must 
be assigned to a change 
request.

z Transport procedure for an automatic transport link

Edited objects are assigned 
to a change request and 
released from the Transport 
Organizer.

Import all objects from 
the change request. 
Exception:
Objects locked for 
import.

Transport Organizer

 
 

� The prerequisite for automatic transport links is that the automatic recording requirement has been 
activated in the source client. 

� Procedure: 

1. When Planning objects are saved in the active plan version, a window is displayed automatically 
in which you can enter a change request, and you assign the objects to a change request.  If a 
change request has not been assigned, data is not saved. 

2. You use the Transport Organizer (transaction SE10) to release the change request. 

3. All of the objects from the change request are imported into the target system. 

� If you want to use this type of transport, you must perform the Set Up Transport Connection 
customizing activity to select the automatic transport connection is activated option. 
To do so, enter the value '  '  (SPACE) (TRSP CORR = '  ' ). 
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Manual Transport Link

If Planning infotypes are 
created, changed, or 
deleted, the system does 
not require a change 
request.

z Transport procedure for a manual transport link

RHMOVE30:
z Select objects
z Assignment to request; release

through Transport Organizer

Import all objects from 
the change request. 
Exception: 
Objects locked for 
import.

Objects
 Pl. ver.
 O. ty.

Transport
 Task
 Request

Objects
 Pl. ver.
 O. ty.

Transport
 Task
 Request

Requests of user

   Modifiable

      Transportable

         SY1K23..

Requests of user

   Modifiable

      Transportable

         SY1K23..

Transport OrganizerTransport Organizer

Manual Transport LinkManual Transport Link

 
 

� Procedure: 

y You edit Planning objects, but a change request is not required when you save. 

y You start report RHMOVE30 (= manual transport). 

y You select all of the objects that need to be transported. 

y You assign the objects to a change request. 

y You use the Transport Organizer (SE10) to release the change request. 

y All of the objects from the change request are imported into the target system.  

� If you want to use this type of transport, you must perform the Set Up Transport Connection 
customizing activity to select the no automatic transport connection option. 
To do so, enter the value 'X' (TRSP CORR = X). 

� You can start report RHMOVE30 (Manual Transport Connection) directly, or by executing the 
Manual Transport customizing activity 

� Note: A request created with report RHMOVE30 must be released immediately using transaction 
SE10. There is no recording requirement, so releasing the request immediately ensures that it is not 
changed in the period between its creation and its release. 
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Transport Using Object Lock

If Planning infotypes are 
edited, the system does 
not require a change 
request but does require 
a repair flag to be set for 
the object.

z Transport procedure for a transport link using an object lock

RHMOVE50:
z Select objects using a

repair flag
z Assignment to request;

release through Transport
Organizer

Import all objects from 
the change request. 
Exception:
Objects locked for 
import.

Transport
 Task
Request

Transport
 Task
Request

Requests of user

   Modifiable

     Transportable

        SY1K23..

Requests of user

   Modifiable

     Transportable

        SY1K23..

Transport OrganizerTransport Organizer

Transport  via Obj. LockTransport  via Obj. Lock

 
 

� Procedure: 

1. You edit Planning objects, but a change request is not required when you save. Instead, a setting is 
made for the changed object in table PLOGI or PLOGI_DEL (for deletions). 

2. You start report RHMOVE50 (= Transport of Objects Using Object Lock). 

3. You select a change request. All of the changed or deleted objects (in other words, all of the 
objects for which a repair flag has been set in the PLOGI or PLOGI_DEL tables) are written to 
this request. At the same time, the repair indicator in the PLOGI or PLOGI_DEL tables is reset for 
these objects. 

4. You use the Transport Organizer (transaction SE10) to release the change request. 

5. All of the objects from the change request are imported into the target system. 

� If you want to use this type of transport, you must perform the Set Up Transport Connection 
customizing activity to select the transport using object lock option. 
To do so, enter the value 'T' (TRSP CORR = T). 

� If you want to transport objects to a number of systems, use report RHMOVE60 Transport Planning 
Objects Into Next System. This report enables all of the objects included in an "arriving" request to be 
transferred to a "departing" request. 
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Consistency Check After Data Transfer and
Transport

Database
OTYPE OBJID INFTY … ISTAT BEGDA
O 00000055 1000 1 01.01.1998
O 00000055 1001 1 01.01.1997
...
O 00000055 1000 2 01.01.1998
O 00000055 1000 1 01.01.1998
…
O 50505072 1000 1 01.01.1998
O 50505073 1000 1 01.01.1998  

Request 
Key list
TABU HRP1000
TABU HRP1001
...

Check database consistency 
Checked objects
Status/validity error
Status error 1
Validity error 1 

RHCHECK1

The following object IDs exceed the 
current number range status 
NR object Subobj. Curr.stat. OBJID
RP_PLAN $$$$ 40404000 50505072
RP_PLAN $$$$ 40404000 50505073
……

RHCHECKP

 
 

� After you have transferred data or performed a transport, you can use the following reports to check 
consistency: 

� Report RHCHECK1 checks the consistency of Planning data records: 

y Infotype validity within object validity 

y Infotype status versus object status 

y Existence of an inverse relationship  
If you need to create missing inverse relationships, use report RHCHECKV 

� Report RHCHECKP performs the following checks: 

y Consistency and uniqueness checks for table and additional data pointers 

y Number range checks: if the number range check highlights inconsistencies, you must update the 
number range statuses 

� You can also start the following reports to check consistency:  

y RHCHECKV to check that inverse relationships are complete 

y RHCTIMCO to check that time constraints are consistent 
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The following object IDs exceed the 
number range status T
NR object Subobj. Curr.stat. OBJID

PRP_PLAN $$$$ 40404000 50505072
RP_PLAN $$$$ 40404000 50505073

Updating Number Range Statuses

Interval maintenance

Number range object RP Plan
Subgroup$$$$

No
EX
IN

From no.
50000000
00000001 

To no.
99999999
49999999

No. status

40404000

Ext
X

Subgroup
$$$$
01$$
020
...

Int. number range
IN
IN
IN

Ext. number range
EX
EX
EX

 
 

� Data transfers and transports can lead to inconsistent number range statuses, which means the system 
contains object IDs that exceed the current number range status of an internal number range. If this is 
the case, you must update the current number range status in the intervals concerned. 

� To update number range statuses, choose the following path in the Implementation Guide: Personnel 
Management -> Organizational Management -> Basic settings -> Number range maintenance -> 
Maintain number ranges. 
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Steps For Data Transfers

Conversion

Legacy
system(s)

Sequential
file

R/3 System

Data transfer

 
 

� In this unit, "data transfer" means transferring data from a non-SAP or legacy system to the SAP 
System. 

� When data transfer objects are transferred, data stored in the legacy system is converted to a 
sequential file and then transferred to the R/3 System using specific transfer programs. The data 
transfer file must contain the data in a specific format that is suitable for SAP. Converting the data 
with a correct format is a prerequisite for transferring data successfully. 

� The first step - that is, mapping and converting structures in the customer system to the structures of 
the SAP System - is supported by the LSM Workbench as a mapping tool.  

� The second step is supported by the Data Transfer Workbench. 
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Data Transfers in HR (Overview)

� Data transfer programs are available for the following HR
components/object types:

z Personnel Administration/BUS1065 (employees):
Î Transfer infotype records in Personnel Administration

z Personnel Planning/PDOTYPES (PD object types):
Î Transfer infotype records in Personnel Planning

z Payroll/BUS7023 (manager for transferring payroll
accounts):
Î Transfer payroll accounts

 
 

� The data transfer programs for Personnel Administration, Personnel Planning, and Payroll are 
integrated with the Data Transfer Workbench. Start transaction SXDA and define data transfer 
projects for the following object types: 

y BUS1065 Employees (Personnel Administration) 

y PDOTYPES PD object types (Personnel Planning) 

y BUS7023 Manager for transferring payroll accounts (Payroll) 

� The Data Transfer Workbench facilitates central access of all data transfer activities for a data 
transfer object. By choosing Goto Æ Analyze files and data structures, you can access functions for 

y Creating, changing, and displaying initial files according to the transfer structures 

y Generating model files with correct formats on the basis of existing SAP data 

y Accessing the appropriate transfer programs 
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Data Transfers in Personnel Administration:
Overview

SAP System

RPUSTD00

PAnnnn HR database

Batch input session

Infotype entry
entry screen

Start batch input session

External 
database

Sequential 
file

 
 

� Procedure: 

y The data to be transferred is written to a sequential file. 

y Model report RPUSTD00 imports the data from the sequential file, and prepares it as a batch input 
session. 

y When the batch input session is started, the infotype entry screens of the "Transfer (EDP)" 
personnel action are filled, and the data is stored on the HR database. 

y The prerequisite for transferring data is a configured, tested system. 
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Structure for Transferring Administration Data

Name: HRDATASET (structure)

Field name

PERNR
BEGDA
WERKS
PERSG
ANREX
........
........
........ 
........ 
........ 
........
........
.INCLUDE

Data element

PERNR_D
BEGDAE
PERSA
PERSG
ANREX

CI_HRDATAS

Short text

Personnel no.
Start date
Personnel area
Employee group
Form of address text

 
 

� The structure of the record is determined by reconciling the data fields in the legacy system with the 
data fields in the infotypes. 

� In the standard system, the HRDATASET structure contains the data definition of a sequential file 
record. 

� Additional fields can be included in customer include structure CI_HRDATAS. 

� In this case, report RPUSTD00 and the transfer action must be adjusted accordingly. 
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Data Transfers in Personnel Planning: Overview

SAP System

RHALTD00

HRPnnnn HR database

Batch input session

Infotype
entry screen

Start batch input session

External 
database

Sequential 
file

HRPnnnnTest system

RHMOVE00

RHMOVE40

 
 

� Procedure: 

y Create the transfer file: 

y Report RHMOVE00 transports Planning data records from the R/3 System to a sequential file. 
It is used as a model report for creating sequential datasets with the correct format.  

y Edit the transfer file: 
This sequential dataset can be displayed and edited using report RHMOVE40. 

y Perform the data transfer: 

y Report RHALTD00 uses a sequential dataset to create a batch input session, which can then be 
processed. 

y The prerequisite for transferring data is a configured, tested system. 
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Structure for Transferring Planning Data

Name: E1Pnnnn (structure)

Field name

MANDT
PLVAR
OTYPE
OBJID
INFTY
SUBTY
ISTAT
PRIOX 
... 
... 
... 
... 
...

...

...

...

...

...

...

Short text

Client
Plan version
Object type
Object ID
infotype

 
 

� The structure of the sequential file is determined as follows: 
Structure E1Pnnn must be used for records of infotype Pnnnn. This is the IDoc segment structure of 
the infotype, whose only difference from logical structure Pnnnn is that all of the packed fields are 
replaced by fields in an appropriate character format. This means that data is only transferred on the 
basis of CHAR fields. 

� Structure E1Pnnnn is expanded for table infotypes - that is, it contains the primary record and the 
table division of the table infotype. 

� Structure E1PADnn must be used for relationships with additional data of structure PADnn. For the 
assignment, see table T77AD. 
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Binding: Transferring Payroll Accounts

INSERT_LEGACY

External 
database

Sequential 
file

T558B/D/ET558B/D/E

RPCALCx0*

RX
Payroll results: 
cluster Rx*

Interface tables

Payroll driver:
schema  xLK0*

BAPI

SAP System

PCL2PCL2

 
 

� Procedure: 

� The payroll results to be transferred are written to a sequential file with the following structures: 

y E1BP7023_PAYPERIODS or BAPI7023_PAYPERIODS (payroll periods) 

y E1BP7023_WAGETYPES or BAPI7023_WAGETYPES (wage types)  

� The Data Transfer Workbench uses this file to generate an IDoc segment. 

� The INSERT_LEGACY BAPI processes this IDoc segment, and fills interface tables T558B, 
T558D, and T588E for legacy data transfers of payroll results.  

� The payroll driver uses schema xLK0* "transfer/payroll account" to read interface tables T558A, 
T558D, and T558E, and then prepares them as a payroll result. The result is stored in cluster Rx* of 
database table PCL2 (*x = country indicator). 
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ALE, Transport Link, and Data Transfer: Summary

z This unit has given you an overview of the
techniques used to transfer data to the HR System.

z You have learned how the transport link functions
for Planning infotypes.

z You have learned about steps and utilities that
ensure the consistency of your data after it has
been transferred and transported.

z You have learned the basics of ALE distribution
in HR.
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Exercises 

 
 

 
Unit: ALE, Transport Link, and Data Transfer 
Topic: Transport Link for Planning Infotypes 

 
 

• Outline the manual transport link 

• Outline transports using an object lock 

 
 

 
You want to transport the organizational structure from an SAP system to 
a different system.  

1-1 Create a transport request for the following example structure in plan version 01 using a 
manual transport link. 

• Plan version = ‘01’ 

• Object type = ‘O’ 

• Object ID = ‘00000001’ 

• Evaluation path = ‘ORGEH’ 

• Display depth = ‘2’ 

Use transaction SE10 to check the request. 

1-2 In Organizational Management, create an example organizational structure with one 
organizational unit and three positions. Create a transport request with this structure 
using an object lock. Which value is required by the transport switch in transaction 
OCCR?  
 
Once again, use transaction SE10 to check the request. If necessary, search for your 
objects in the requests created by other groups.  
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Solutions 

 
 

 
Unit: ALE, Transport Link, and Data Transfer 
Topic: Transport Link for Planning Infotypes 
 

1-1 Start report RHMOVE30 for the following structure: 

• Plan version = ‘01’ 

• Object type = ‘O’ 

• Object ID = ‘00000001’ 

• Evaluation path = ‘ORGEH’ 

• Display depth = ‘2’ 

• Test = ’  ‘  

Use transaction SE10 to check the request. 

1-2 To perform a transport with object lock, the value of the transport switch in transaction 
OOCR must be ‘T’.  
After you have created the example structure in plan version 01, start report 
RHMOVE50 with the Test parameter set to ‘ ’. One group's objects could appear in the 
requests of other groups, depending on when a particular group finishes maintaining the 
structure and starts report RHMOVE50. If you need to perform a search, use 
transaction SE10 → Transport Organizer Tools. 
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Creation of Infotype Logs, Logging, and Archiving
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At the conclusion of this unit, you will be able to:

z Ensure that logs are created automatically 
for personnel data and applicant data, and 
when reports are started.

z Use archiving functions to remove data that is no 
longer required from the database, and store it so 
that you can still report on it.

z Scan in and archive original documents using the 
document archiving functions of SAP ArchiveLink.

Creation of Infotype Logs, Logging, and Archiving:
Unit Objectives
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Introduction

Data Structures in HR

Customer Infotypes

ALE, Transport Link, and Data Transfer

Creation of Infotype Logs, Logging, and Archiving

Enhancement Options

Course Overview Diagram
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Creating Infotype Logs and Logging

 HR data  HR dataHR data

Personnel file

Document file

 
 

� When personnel or applicant data is processed, the R/3 System creates a personnel or applicant 
master record for infotypes to be logged. At the same time, it stores a log document in the document 
file.  

� You can display the documents using report RPUAUD00. 

� You can also log report starts.  

� Reports RPUPROTD and RPUPROTU enable you to display logs, or delete them from the 
database. 
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IMG: Set Up Change Documents

Infotypes to be logged

Transaction classTransaction class InfotypeInfotype

A

B

0002 Personal Data

4000 Applicant Actions

Field group definition

InfotypeInfotype Field groupField group

0002

0002

01

01

4000 01

Field nameField name

NACHN

VORNA

*

Field group characteristics

Transaction classTransaction class InfotypeInfotype

A

B

0002

4000

DFGDFG

01

01

Doc.typeDoc.type

L

L

SFGSFG

00

02

 
 

� You set up change documents in Customizing. To do so, you determine which infotypes must be 
logged. The following options are open to you: 

y The changes within an infotype are logged for specific fields. You decide which fields are logged. 

y You can group infotype fields together to create "field groups", which are always logged as a unit. 
Even if just one field in the group is changed, all of the fields in the group are logged. 

y You can define dependencies between field groups. In other words, you can specify a 
"supplementary field group" for each field group, which is always logged as well. 

� Customizing the function for creating infotype logs involves three steps: 

1. Determine Infotypes to be Logged 

2. Define Field Groups 

3. Determine Characteristics of Field Groups 
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Step 1: Determine Infotypes to be Logged

Infotypes to be logged

Transaction classTransaction class InfotypeInfotype

A

B

0002 Personal Data

4000 Applicant Actions

 
 

� If you change an infotype that must be logged, the function for creating an infotype log is triggered. 
If infotypes do not need to be logged, the function for creating an infotype log is not triggered.  

� Transaction class "A" applies to the creation of infotype logs for HR master data. Transaction class 
"B" applies to the creation of infotype logs for applicant data. 
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Step 2: Define Field Groups

Field group definition

InfotypeInfotype Field groupField group

0002

0002

01

01

4000 01

Field nameField name

NACHN

VORNA

*

 
 

� You must specify all of the fields within an infotype that need to be logged.  

� The input help function enables you to display and immediately select all of the fields within an 
infotype.  

� You can also group fields within an infotype together to create "field groups". When an infotype log 
is created, all of the fields in a field group are regarded as a single unit and logged together, even if 
just one field has been maintained. 
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Step 3: Determine Characteristics of Field Groups

Field group characteristics

Transaction classTransaction class InfotypeInfotype

A

B

0002

4000

DFGDFG

01

01

Doc.typeDoc.type

L

L

SFGSFG

00

02

 
 

� In this step, you specify which field groups need to be logged.  

� You can also specify "supplementary field groups" (SFG) for each field group. Supplementary field 
groups are always logged if a field changes in the "trigger" field group (DFG).  

� Furthermore, this step enables you to specify whether the document is entered as a long-term (L) or 
short-term (S) document. The "short-term document" type is not supported at this time. 
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Reporting and Reorganization

ActivityInfotype key ....

Last name
First name

Old

Thomas
Thomas
Walter

Logged Changes

Read documents from database
Long-term documents
Short-term documents

Selection
Transaction class Master data Appl. data All
Personnel no.
Infotype
Changed on
Changed by

to
to
to
to

Output options
Direct output of docs New page per doc.
Output program selections

Sort order Time Personnel no. Infotype User

Default currency

Field name New U

Walter

 
 

� Revision program RPUAUD00 enables you to display all of the changes in personnel data or 
applicant data for a specific period of time. 

� Document records can be sorted by date and time, personnel or applicant number, infotype, or user 
name.  

� You can also search for specific long-term or short-term documents, as well as documents for HR 
master data or applicant data. 

� The Default currency field enables you to enter a default currency. If a log record for an amount field 
does not contain a currency, the system tries to determine one by using the organizational assignment 
of HR master data or applicant data. If this does not succeed in finding a currency, processing 
continues using the currency specified in the Default currency field. 

� The log list includes the field name, old and new field contents, and the activity that has been 
performed - that is, whether data has been added (I), changed (U), or deleted (D). 
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X

X

IMG: Log Report Start

Online logPrograms

RPLMIT00

Batch log

RPLPAY00

RPUPROTD
Display

log

RPUPROTU
Maintain

log

 
 

� Logs for report starts, just like infotype logs, are created for revision purposes.  

� If you activate this function, each execution of the selected report is recorded on the database. You 
can determine for each report whether this logging function is used for online starts, background 
starts, or both.  

� The following data is included in the log for each report start: 

y Report name 

y Changed by 

y Date of report start 

y Time of report start 

y Report parameters and select options 

� Reports RPUPROTD and RPUPROTU enable you to display this information, or delete it from the 
database. 
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Data Archiving

R/3 DB

Archiving
objectDocuments Archive

files

Archiving run

Reporting

 
 

� Archiving is used to delete data from the database that is no longer required in the system, but which 
must be stored elsewhere so that you can still report on it (to meet statutory requirements, for 
example). Archiving objects are used to write documents to archive files, which can be stored 
elsewhere using other media. The archiving object determines what is archived, and how archiving is 
performed.  

� The archiving procedure can be divided into two basic steps: 

y Create archive files: When archiving is performed, the data to be archived is written sequentially 
to a new file. These archive files can be transferred to an archiving system using SAP 
ArchiveLink, for example. 

y Start deletion program: On the basis of the archive files that you have created, the deletion 
program deletes data from the database. 

� A distinction is made in HR between archiving change documents, and archiving data (payroll 
results, time evaluation results, and trip data). 
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Archiving Change Documents

z Archiving object:
� PA_LDOC is used to archive long-term 

documents that are the result of creating 
infotype logs

z Archiving (SARA)

 
 

� To enable you to archive long-term documents that result from the creation of infotype logs, the 
long-term documents (PA_LDOC) archiving object has been defined.  

� The "long-term documents" type is only used for revision purposes. This means that changes are 
logged in a separate table, and stored there until they are deleted. These long-term documents can be 
for personnel or applicant numbers. 

� You can archive documents from any period. The function for creating infotype logs is optional, 
which means you can even archive documents from the current week. The period for which data is 
archived depends to a great extent on whether data from the recent past, for example, is still required 
on a frequent basis. If this is the case, the data must remain in the system. If data is hardly ever 
required, it can be archived, even if it is very recent. 

� The PA_LDOC archiving object is archived by the Archive Management transaction (SARA). 

� Report RPUAUD00 enables you to display archived long-term documents. 

 

 

 

 
                                         

 



© SAP AG HR530 6-13 

  SAP AG 1999

Archiving Data

z Archiving objects:
� PA_CALC for archiving payroll results

� PA_TIME for archiving time evaluation results

� PA_TRAVEL for archiving trip data

z Archiving using archiving group (PU22 + SARA):
� Prepare archiving (PU22)

� Archive (SARA)

z Archiving data is stored in infotype 0283 Archived Objects 
for every personnel number.

 
 

� The archiving group is a special structure for archiving data. It enables you to combine the archiving 
objects of the Payroll, Time Management, and Travel Management components, provided that these 
components are integrated. The archiving group makes it easy for you to group personnel numbers 
together whose data must be archived (for example, all of the employees at an international 
subsidiary, or all of the employees who have left the enterprise).  

� After you have prepared data for archiving using transaction PU22 HR Archiving, archiving objects 
PA_CALC, PA_TIME, and PA_TRAVEL are archived using transaction SARA Archive 
Management: 

y Prepare archiving (PU22): Time is not a critical factor. 

 Determine the archiving group and archiving date. 

 Assign the required personnel numbers to the archiving group. 

 Check these personnel numbers to ensure that the data can be archived. 

 Remove data on the specified personnel numbers from the system. From the payroll perspective, 
for example, data is regarded as archived up to the archiving date. 

y Archive (SARA): Time is a critical factor. 

 Archive each prepared archiving object separately on an external data carrier. 
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IMG: Set Up Data Archiving

z Cross-application customizing

z HR-specific customizing:
� PA_LDOC

� PA_CALC

� PA_TIME

� PA_TRAVEL

 
 

� Data archiving is a cross-application function. For this reason, Customizing for data archiving is 
divided into general cross-application customizing, and HR-specific customizing. 

� In cross-application customizing, you determine technical values for the archiving run, such as the 
name, path, and maximum size of the archive file, and settings for the deletion program.  

� In HR-specific customizing, you set parameters that only apply to the respective archiving object. 
Customizing settings are not required for the PA_LDOC, PA_CALC, PA_TIME, and PA_TRAVEL 
archiving objects. 
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Document Archiving - Overview

Reporting
01.01.96

Optical Archive

Archiving

 
 

� By using SAP ArchiveLink in Personnel Administration, you can store copies of incoming 
documents - such as employment contracts, appraisals, and employee photos - in external storage 
systems. The personnel file expands over time due to a constant increase in the number of paper 
documents that it contains. The HR Department can save time and money by managing it centrally. 

� The original written documents are imported into the system using an external scan program. The 
scan program communicates with SAP ArchiveLink. Individual documents are related directly to an 
infotype and an employee/applicant (using the personnel or applicant number), or they are generally 
assigned to the employee/applicant using the personnel or applicant number. This relationship is 
established using document types.  
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Storing for Subsequent Entry

Central scan point

Document type
 assigned

Business Workplace for ...

Workflow inbox

 
 

� If the Storing for Subsequent Entry storage scenario is performed, incoming original documents for 
the employee/applicant are entered centrally (typically in the mail department at the enterprise), 
classified by document type, and archived. Using SAP Business Workflow, the scanned document 
is then forwarded to the inbox of the appropriate personnel administrator. After the personnel 
administrator has made a final decision on the assignment to a document type, he or she can 
conclude the archiving procedure by processing the appropriate infotype and relating the document 
to this data record, or send the document to another administrator for further processing. 

 

 

 

 
                                         

 



© SAP AG HR530 6-17 

  SAP AG 1999

Store and Enter

ScannerScanner

Master data
administrator

Applicant
administrator

Time 
administrator

 
 

� The only difference between the Store and Enter and Storing for Subsequent Entry storage scenarios 
is that the former requires the administrator in the HR Department to scan the incoming document 
into the system. The inbox is not used. 
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Late Storing With Bar Codes

Central scan point

Administrator

Bar code

Infotype, subtype,
Document type

 
 

� If the Late Storing With Bar Codes storage scenario is performed, the incoming document is received 
by the appropriate HR administrator. He or she sticks a bar code label onto the document, and then 
uses HR master data maintenance to assign the bar code to a personnel number and, if necessary, a 
special infotype. 

� The document is then forwarded to the scan point for scanning. When employee documents are 
scanned later, the system can use the bar code to assign them to the employee automatically. 

� If you decide not to use bar codes, the information required for correct archiving and for assigning 
the document to an infotype must be made available to the scan point in some other way. Such 
information includes the infotype, subtype, personnel or applicant number, and document type. This 
storage scenario is called Assign Then Store. 
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IMG: Set Up Document Archiving

Object type Document type Text Infotype Subtype Object ID Date Authorization

PREL HRITAXCARD Tax card 0012 - - + x

PAPL
...

HRIRESUAPL Resume of 
applicant

- - +

 
 

� Document archiving is a cross-application function. Therefore, customizing for document archiving 
is divided into general cross-application customizing, and HR-specific customizing. 

� To perform cross-application customizing, access the Implementation Guide and choose Basis 
Components → Basis Services → SAP ArchiveLink.  

� To perform HR-specific customizing, access the Implementation Guide and choose Personnel 
Management → Personnel Administration → Tools → Optical Archiving. At this point, you set up 
the document types. To do so, you assign an infotype, subtype, and object ID to different document 
types as necessary. Furthermore, you can determine whether the original document's date of origin is 
displayed as a required or optional field. Depending on the document type, you specify whether the 
employee must be authorized for the infotype in question if he or she wants to enter a particular 
document and then assign it to a document type. 
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Creation of Infotype Logs, Logging, and Archiving:
Summary

z Describe how to set up change documents 
in Customizing.

z Name the HR-specific archiving objects.

z Explain the three document archiving 
methods, and name the required 
activities in Customizing.
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